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General Safety Precautions

GENERAL SAFETY PRECAUTIONS

The bbe AlgaeOnlineAnalyser is an instrument for the determination of the concentration of
chlorophyll in water. It should only be used for this purpose.

e only instructed staff should operate this instrument.

e consult appropriate safety manual in case of using hazardous compounds and
solutions. Wear gloves, coat and safety goggles.

e electrical connection of the instrument should only be carried out by trained staff.

e the instrument should only be opened by authorized staff.

e please refer to the safety instructions of any chemicals used with the
AlgaeOnlineAnalyser.

e changes to electrical connections and circuits may cause damage to the instrument
and lead to loss of warranty.
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The AlgaeOnlineAnalyser

THE ALGAEONLINEANALYSER

USE OF THE ALGAEONLINEANALYSER

The AlgaeOnlineAnalyser is an instrument for the analysis of algae in rivers, lakes or reservoirs. It is usually
used in a monitoring station. Depending on the configuration of the instrument, there are various parameters
which can be determined:

e the total concentration of chlorophyll

e the concentration of up to 5 algae groups (algae differentiation)
e the activity or production rate of these algae groups (Option)

e the transmission of 5 wavelengths (Option)

e detection of yellow substances

The user receives an instrument for the complete survey of the algae content of waterways.

COMPONENTS

The main components of the bbe AlgaeOnlineAnalyser are:
e The sensor unit with cleaning device

e Housing with power-supply and pump (optional valves for multichannel operation)
e PC unit with touchscreen display

AlgaeOnlineAnalyser front view
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The AlgaeOnlineAnalyser

THE SENSOR UNIT WITH CLEANING DEVICE

Here the actual measurement is processed. The sample is pumped into the cuvette from below. There the
fluorescence is measured with light of different intensity and colour. The data is analysed by a microcontroller
integrated into the sensor unit and transferred to the PC. After a certain number of measurements the cuvette is

cleaned automatically by the cleaning device.
The humidity detector prevents greater damage to the sensor in case of leakage.

ﬁ \
b
. ,

cleaning
device

[~

chamber

l measuring

outlet

=

z inlet

removable
lid for
cleaning
purposes

g

i
i
N

cross-section of the sensor unit (Chlorophyllsensor)
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The AlgaeOnlineAnalyser

Pump

The bbe Algae Online Analyser also uses a peristaltic pump — the only degradable part is the hose.

The rolls on the rotor press the hose against the hose saddle and close it at that point. So there is a constant
volume between the two rolls that is delivered in the direction of the rotor.

The quantity delivered depends on the number of revolutions of the pump and on the inner diameter of the
hose.

Another advantage is the use of several channels per head. This offers the possibility to have the pumping rates
depend on each other and to be determined by the relation of the inner diameters of the hoses.

The hoses of the sample pump are put under considerable strain so we recommended the hoses be changed
every 4 weeks.

OPERATING

1 Tube clamp setting. Predisposizione del morsetto del
tubo. Justera slangklimmen. Einstellung der
Schlauchklemme. Fjar la abrazadera para tubos.
Afstellen van slangklemmen. Réglage du serrage du
tube. Predisposizione del morsetto de tubo. Putken
kiinnikkeen asettaminen. Innstilling av slange klemme.
3 Indstilling af slangeklemmer.

z Tube wall thickness. Spessore delle pareti del tubo.

groviek. des
Grosor de la pared del tubo. Wanddikte pompslang.

Epaisseur de la paroi du tube. Spessore delle pareti del
tubo. Putken seinimin vahvuus. Veggtykkelse pé
slange. Vaagtykkelse.

3 Setfor tube bore size. Predisposto per le dimensioni del
diametro del tubo. Stéll in fér olika slangstoriekar. Sauz
for Grofle der Schlauchbohrung. Fjar para el tamafio
di-metro interior del tubo. Ingesteld voor slangdoorlaten.
Régler le diamEtre interne du tube. Predisposto per le
dimensioni del diametro del tubo. Asetus putken
halkaisijan koolle. Innstilt sterrelse pé slange diameter.
Instilling af slangediameter

1885 >ﬁ) ,

a—x'8 |
v

(2

Opening the pumphead. Apertura della testa della pompa.

ppna ffnen des P fs. Abrir el
cabezal. Openen van pompkop. Ouverture de la téte de
pompe. Apetura della testa della pompa. Pumpun péén
avaaminen. Apning av pumpehode. Abning af
pumpehovedet.

[
:

J
N

[
[
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The AlgaeOnlineAnalyser

FITTING A PUMP HEAD

VALVES (OPTION)

In case of a multichannel instrument, pinch valves are used. Please use the original type of tubes for proper

operation.

ENVIRONMENTAL CONDITIONS

For the installation of the bbe Algae Online Analyser a frost-free room has to be chosen. The temperature must

not exceed 35°C.

storage

Parameters Values
Temperature range during use 5-35°C
Temperature range during 0-50°C

Relative humidity

up to 95 %, non-condensed

Exposure to sunlight

No direct exposure to sunlight

Minimum distance from the wall

10 cm

Maximum pressure

0.5 bar above atmospheric pressure

Manual for the bbe AlgaeOnlineAnalyser

Page 13



The AlgaeOnlineAnalyser

A free drain should also be provided. The bbe Algae Online Analyser is built as a tabletop instrument.

ELECTRICAL CONNECTIONS

SUPPLY CONNECTION

The bbe AlgaeOnline Analyser is supplied with a mains cable with a safety plug. When connecting the
instrument, please ensure a waterproof connecting socket.

DATA INTERFACES

RS232 data output

Important:
Please switch off the AlgaeOnlineAnalyser and the external device before connecting the RS232 cable.

The AOA provides a RS232 data output. This is available on a free RS232 port of the external PC or via the
RS232 output cable when using an internal PC.

Ethernet

The AOA can be integrated in a LAN. The LAN cable has to be connected directly to the PC. To do so the cable
has to be lead through the cable inlet at the right side of the housing.

ANALOG OUTPUT —4-20 MA (OPTION)

Algae Online Analysers can be equipped with 2 or more analog outputs as an option. In this case, there are one
or more 4-pin plug connector(s) mounted on the instrument. An extra plug that can be attached to the on-site
connection cable is also supplied.

Please note: Common ground lines are not supported. The Ground lines of the 4-20mA outputs must be
isolated from each other.
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The AlgaeOnlineAnalyser

1: output 0 + Gnd: output 1 -
2: output O - 3: output 1 +
connector
from the
‘screw-side’
1: output 2 + Gnd: output 3 -
2: output 2 - 3: output 3 +
connector
from the
‘screw-side’

In case of more analog outputs, the following connectors are marked consecutively.

RELAY OUTPUT (OPTION)

The Algae Online Analyser can be equipped with a relay output device.
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The AlgaeOnlineAnalyser

Connecting the relay output device

There are two (or more) 7-pole connectors on the right side of the instrument. The corresponding cable
connector is delivered together with the accessories.

Table of connection:

Connector

Pole

Printed on the connector

Function

1

Relay 2 / Common

Relay 2 / Normally Open

Relay 1/ Common

—_

Relay 1 / Normally Open

= o O M| W N

Relay 4 / Common

Relay 4 / Normally Closed

Relay 4 / Normally Open

Relay 3 Common

Relay 3 Normally Closed

N N N N NN

| O A WO DN

Relay 3 Normally Open

Manual for the bbe AlgaeOnlineAnalyser
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The AlgaeOnlineAnalyser

HYDRAULIC CONNECTIONS

CONNECTIONS OF THE CHLOROPHYLL SENSOR

Outlet / drain

Inlet

WITHOUT INTEGRATED SAMPLE PUMP

The sample has to flow continuously through the instrument. For this, a maximum pressure of 0.2 bar is
allowed. Please ensure that this pressure is not exceeded, even if the effluent is blocked. The inlet is on the
bottom in the center of the removable lid.

WITH INTEGRATED SAMPLE PUMP

Connect the intake of the integrated pump to the water source and the outlet of the pump to the connector at the
bottom of the sensor of the AlgaeOnlineAnalyser.
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The AlgaeOnlineAnalyser

MULTICHANNEL VERSION

Integrating valves in the AOA extends the instrument to a multi-channel device. The valve can be used with and
without the peristaltic pump. The pump is required as soon as the pressure of one of the sample streams is not
sufficient.

Tubing diagram with valves and pump

Valves (1-8) Pump to the Sensor

Channel 1 ‘
Channel 2 ‘

Channel n ‘
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The AlgaeOnlineAnalyser

Tubing diagram with valves only

Valves (1-8) to the Sensor

Channel 1 ‘
Channel 2 .

Channel n ‘

DRAIN

The drain of the instrument needs to be fed into an open, pressure-free drain.

QUICK START

e Connect the mains

e Connect the LAN/RS232 /4-20mA

e Connect the hoses

e Close the peristaltic pump

e Switch the instrument on and let the PC boot

e Adjust pumping time and procedure according to your needs
o Start the measurement using the “start” button

o The measurement can be stopped at any time via the “stop” button

MEASUREMENT PROCEDURES

First of all, a survey of the single steps of a measurement.

MEASURING SEQUENCE (STANDARD SEQUENCE)

Pumping during startup or opening the sample valve

Brightness tuning of the internal LED

Pumping sample or opening the sample valve
Measurement (including activity measurement if available)
Cleaning

Waiting for the next measurement

Go to step 2

Nooh~wN =

MEASURING SEQUENCE (FLOW THROUGH)

Flushing during startup

Brightness tuning of the internal LED
Measurement (concentration measurement only)
Cleaning

Waiting for the next measurement

Go to step 2

ookrwn =
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The AlgaeOnlineAnalyser

MEASURING SEQUENCE (MULTICHANNEL VERSION)

Pumping channel 1 during startup or opening the sample valve 1
Pumping channel 2 to n during startup or opening the sample valve 2 to n

Brightness tuning of the internal LED

Pumping sample or opening the sample valve for the current channel
Measurement (including activity measurement if available)

Cleaning

Go to step 2 for channel 1 to n

Waiting for the next measurement

N>R M=

INTERVAL PUMPING VS. CONTINUOUS PUMPING

Two operation modes for the pump and/or the valves are selectable:

e |[nterval mode or

e Continuous mode.

Interval mode

The pump is working (or the valve is opening) before each measurement and it is not working during the
measurement.

Advantages;
This enables to perform activity measurements.
The working time of the pump and the tube is short, the lifetime extended.

Disadvantages;

Measurement is slower
In multichannel applications it takes longer to exchange the sample

Continuous mode.

The pump is working (or the valve is opening) all the time for fat response. Not suitable for activity
measurements.
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bbe++ Software

BBE++ SOFTWARE

The bbe++ software is delivered together with bbe instruments. If a PC is delivered with the instrument or
integrated in the instrument, the software is already installed.

It provides the following functions:

e operation, control and calibration of bbe instruments
e data analysis and display in tables and diagrams

e export in different formats

This chapter describes the general functions of the bbe++ software. The examples may show data or
parameters of other bbe instruments. The data and parameters of your instrument can easily be handled
accordingly. Whenever this manual deals with special features of a certain instrument, this will be explained in
the special instrument chapter.

The data and parameters of the instruments are stored in a database. A single database may contain the data
of different instruments of the same type and also different types of instruments.

SOFTWARE SET-UP

The software is stored on a CD delivered with the instrument. The latest version can also be downloaded from
the bbe website after registration (http://www.bbe-moldaenke.de/log-in/ ).

The Windows autorun function should start the installation automatically. If it does not, open the Explorer and
click on setup.exe on the CD for installation.

Welcome window: click “NEXT >”"

® bbe+ + Setup o (=]

Welcome to the bbe++ Setup Wizard

This wizard will guide vwou through the installation,

‘e recommend that you close all other applications before
starting the setup. This will make it possible b update
relevant system files without having ko reboot your
compuker,

Click Mest to continue,

WARMING: This program is protected by copwright law and
international treaties, Unauthorized reproduction or
distribution of this program, or any portion of it, may resulk
in sewvere civil and criminal penalties, and will be prosecuted
to the maximum extent possible under law,

Cancel |
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bbe++ Software

Choose the destination folder and click “NEXT >”

® bbe++ Setup =] x|
Choose Install Location -
Choose the falder in which wou wish to install bbe++. (,J

Setup will install bbe++ in the Following folder, Tainstall in a different Folder, click Browse and
select a different Folder, Click Mext to continue,

Destination Folder

Browse... |

Space required: 5.2MB
Space available: 23.5GE

< Back I Mext = I Cancel

Choose a new start menu folder and click “NEXT >”

@ bbe + + Setup ==
Choose Start Menu Folder -
Choose a Start Menu folder for the bbe++ shortouts, (JJ

Select the Start Menu Folder in which you would like to create the program's shortouts, ou
can also enter a name to create a new folder,

[

adI) - Adwords Combinator 1.5.1 ﬂ

Advantech Automation
Alviewer Demo

Algae Online Analyser
a5

Ao

Autodesk

Autostart

Avira

bbe++

BlusBozx LI

[ Dot ereate shorkouts

< Back I Mext = I Cancel |

Choose your preferred language and click “NEXT >”
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bbe++ Software

Final success window of the bbe++ installation. Click “FINISH”.

® bbe + + Setup _ o]

The Setup Wizard is complete.

bbe++ has been installed on vour computer,

Click Finish ko close this wizard,

= Back I Finish I Canicel

DESKTOP ICON OF THE BBE++ SOFTWARE

The setup installs an icon for the bbe++ software on the desktop (if chosen during installation).

bbe++

BBE++ SOFTWARE IN THE START MENU

The bbe++ folder in the start menu contains:
> bbe++ software
» installed manuals
> link to the data folder of bbe++
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bbe++ Software

SOFTWARE UPDATE

Updates of the bbe++ software and manuals can be downloaded from the bbe website http://www.bbe-
moldaenke.de after registration.

STRUCTURE OF THE SOFTWARE

The following menus are available in the bbe++ software. Whether a menu is displayed, depends on the access
level set.

FILE contains all the input/output functions.
EDIT contains functions to copy data and graphics.

PARAMETER contains functions to set the parameters of an instrument and to adapt the parameters of data
already measured.

VIEW contains functions to show and hide toolbars.

WINDOW contains functions to show the data in different types of tables and graphics as well as editors to
change the layout (advanced functionality level only)

TooLs contains options to change settings that influence the behaviour of the bbe++ software and the way
of operating the instruments.

CALIBRATION contains the items to calibrate different bbe instruments (advanced functionality level only)

HELP contains information about the current bbe++ version.
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bbe++ Software

MENU STRUCTURE (“BASIC FUNCTIONALITY”)

| | | |

File

New

Close

Import

= Export KMZ

wd Export ToxTest

ad Recent file list

= Data directory

Exit

T
Edit comment

']

|

Template
(not Torches)

View

Toolbar

- Statusbar

s Measurement

Macro

= Data navigation

Period

Session

md connection state

. Auto update

T
-
Enable advanced
y " Manuals
functionality
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bbe++ Software

MENU STRUCTURE ("ADVANCED FUNCTIONALITY”)

Menu

F T

New

Close

Import

Export (ASCII)

Export database

Export KMZ

Export ToxTest

Summary view

Recent file list

Data directory

Exit

Edit comment -

Parameters

S
5
2
5
H

=1 History

Template (not
Torches)

Online

Recalc
(not Torches)

Parametersets
(FluoroProbe only)

- Standard

al  Workstation

View

Toolbar

Statusbar

mll Measureme

Macro

= Data navigation

- Period

- Session

md connection state

b Auto update

Cascade

- Tile

=8 Arrangeicons

wl New list window

- New XY view

o Single value

- Select data

- View editor

al Comment fields

ol Open windows list

Tools

= Settings

Enable basic
functionality

=l CONnect COM port|

- Device

— SQL script

T
Calibration

I-

Manuals
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bbe++ Software

GENERAL CONSIDERATIONS FOR STORING AND DISPLAYING DATA AND PARAMETERS IN BBE++

WHAT IS STORED IN A BBE++ DATABASE?

The measuring results and instrument parameters of different bbe instruments are stored. It is possible to
retrieve the corresponding instrument parameters for each single result.

In the so-called “Summary View” the serial numbers of the instruments and the time ranges for all data stored in
this database are shown. This view can be used to select the desired data as well as the corresponding
parameters for display.

The database files are marked with the extension *.bdb (bbe database)

WHERE IS THE DATABASE STORED?

The database of bbe++ is stored in the standard application folder of Windows. The name of the folder depends
on the operation system and the language. For example: C:\ProgramData\bbe++ in the Windows 7 English
version. To access this folder easily, there is a link in the file menu of bbe++ or start menu of Windows called
“‘Data directory”:

HOW TO DISPLAY THE DATA?

In the bbe++ software, different views have been pre-defined for each instrument:
e graphics
o tables
e single dataset

e data export

User-defined views may be added as well.

SIMULTANEOUS DISPLAY OF DATA OF DIFFERENT TYPES OF INSTRUMENTS

After opening a database file, the data of different instruments of the same type may be displayed
simultaneously. To display the data of another type of instrument from the same database file, this file can be
opened more than once.
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bbe++ Software

WHO CAN ACCESS TO THE PARAMETERS OF THE INSTRUMENTS?

The bbe++ software has 2 access levels — basic functionality and advanced functionality. Depending on the
different access levels, more or fewer menu items and parameters are shown. There are different settings for
reading or writing access. The advanced functionality level can be password protected.

DESKTOP OF THE BBE++ SOFTWARE.

Toolbar

Toolbar Data table

Instrument

Graph 1

Serial number, voltage of
the battery, internal clock

Graph 2
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bbe++ Software

TOOLBAR

Toolbar to navigate within the datasets.

TOOLBAR INSTRUMENT

Toolbar to operate the instrument

GRAPHIC- UND TABLE VIEWS

User configurable windows with graphs and tables.

SERIAL NUMBER, VOLTAGE OF THE BATTERY, INTERNAL CLOCK

Display of the data of the connected instrument: serial number, voltage of the battery and internal clock.
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The Menus

THE MENUS

FILE MENU

The File Menu contains all the input/output functions.

FiIe|Edit Parameters View Window Tools Calibratior

j Mew Strg=M
,_3 Open... Strg+ O
Close
Import L4
Export [ASCI) L

Export (Database]
Export (KMZ / Google Earth)

Export (ToxTest protocol]
Summary View

1 Ch\ProgramData\bbe++\bbe++.bdb

2 ALA_DAtenbank_UV-Versuche_01052014_Hanno.bdb
3 Test_Algenmischung_11022014.bdb

4 Stechlin_Probemessung_berechnete Fingerprints.bdb
5 ChUsers\..\bbe++ (2).bdb

6 bbe== - Kopie.bdb

7 SM\Produkte’..\bbe++.bdb

8 75_21-22 COldbbeDatabase_20130502.bdb

Data directory

Exit
FhoroProbe o AlgzeToch(' ) |

Export Export all

New

Creates a new database file for data and parameters.

If the new database already exists, the existing database is deleted after confirming the following message:
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The Menus

The new and empty database is displayed.

New data can be entered in the database by importing or by starting a measurement.

Open

Opens an existing database. If there are already data in the database, the “Summary View” window appears.
The type and serial number of the instrument can be chosen as well as the time range. The following example
shows a database containing data from different FluoroProbes.

i "

b pewdatabase.bdb EI@

FluoroProbe
FP-21-24 14,07.2011 - 14.07.2011
FP-21-33 14.07.2011 - 14.07.2011

Close

Closes the active database.

Import (FluoroProbe / AlgaeTorch / BenthoTorch)

This function is used to import *.FLP files into the database. These files can be results transferred from the
FluoroProbe to a USB stick or files generated by the first version of the FluoroProbe software.

To import, please choose the file from the file system:
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The Menus

It is possible to select more than one file by pressing the shift key while selecting the file.

FluoroProbe only: Afterwards choose how to apply the air pressure and hence the calculation of depth.

Air pressure as given in file (FluoroProbe and AlgaeTorch 100 only)

Air pressure was measured at the beginning of the measurement. This value is used.

Air pressure from first data set (FluoroProbe and AlgaeTorch 100 only)

The first measurement of air pressure took place in air. This is the appropriate selection if an autostart-plug
without a PC was used (for further information see the FluoroProbe-manual).

Air pressure (FluoroProbe and AlgaeTorch 100 only)

Allows the entry of a constant value. To be used if the FluoroProbe was submerged for a longer time and unable
to measure the air pressure by itself.

In case of FluoroProbe data, the results are recalculated from the raw data after importing.

The calculation procedure takes place in subsequent steps. After importing all data, a success message is
shown.
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The Menus

Export (ASCII

This item exports the data as an ASCII file to load them into other programs. To select columns to be exported
and the separator that is used, please see the description of the View Editor. The view editor allows the user to
define different export formats for each instrument. All export formats of the current instrument are shown in the
menu:

Export Export all

The default export view is “Export all”.
After clicking on “Export all”, the name and folder of the exported file can be selected.

Hint: To transfer data to Excel, use the copy and paste feature in the “Edit” menu.

Export (Database)

This item is used to export parts of a database to a new (and smaller) one. The exported database can be read
with bbe++ again. This might be useful when parts of the database are transferred via email.

The currently selected data (“WINDOW - SELECT DATA”) are exported.

Export (KMZ) — AlgaeTorch / BenthoTorch / FluoroProbe

This item is used to export geo data from instruments with GPS receiver to be displayed in Google Earth.

Export (ToxTest protocol) — AlgaeLabAnalyser only

This item is used to export the results of toxicity tests conducted with the AlgaeLabAnalyser to Excel.

Summary View

Opens a new window that gives an overview of all the data and instruments in the current database:

B bbe+ +.bdb [FP-18-03] :3 =]y
o: I

tlgaeTorch
AT-04-002 01.04.2010 - 07.04.2010
FluoroProbe
FP-12-07 01.04,2009 - 01.04,2009
FP-12-03  15.06,2009 - 15,06,2009
FP-07-01 30.03.2005 - 30,03.2006
FP-15-02 Z2.02.2007 - Z2.02.2007
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The Menus

The database bbe++.bdb above contains data of two types of instruments: AlgaeTorch and FluoroProbe.

The serial numbers and the point in time of the first measurement and the last measurement stored in the
database are shown below the heading with the name of the instrument.

The header of the window (bbe++.bdb [FP-18-03] :3 has the following meaning:

e the name of the database bbe++.bdb
e the serial number of the instrument

for which the data in the data windows are currently shown [FP-18-03]
e the number of the window if there is more than one open window :3

The summary view can be used to directly access the data or parameters of one of the listed instruments. To do
so, use the right mouse click on the serial number:

=10l x|

" FlusroProbe
FP-19-01 11.03.,2011-12.10.2011
FP-21-34 05.07.2011-11.07.2011
FP-21-22

FP-21-26 0&.07.. A&lData

FP-21-32 08.07.. LastDay

FP-21-33 05.07.: Last Week
Last Month
Last Year

History of Parameters

A selection of different periods and parameters are shown. After selecting one of the given periods, it is shown
using the default view.

i bbe -+ +.bdb [FP-15-02] -0 x|
Date,/ Time [date] I Conc 0 [Green Algae] [pgjl]l Conc 1 [Bluegresn] [Lg/1] | Conc 2 [Diatoms] [~

22.02,2007 15:27:25 u] 1,34

22.02,2007 15:27:34 u] 1,43

22.02,2007 15:27:40 ] 1,41

22.02.2007 15:27:47 ] 1,37

22.02,2007 15:27:53 ] 1,45

22.02,2007 15:28:00 ] 1,4

22.02,2007 15:28:06 ] 1,34

22.02,2007 15:28:13 ] 1,35

22.02,2007 15:28:20 ] 1,38

22.02,2007 15:28:26 ] 1,42

22.02,2007 15:28:33 ] 1,3

22.02,2007 15:28:41 u] 1,47

22.02,2007 15:28:48 u] 1,4

22.02,2007 15:28:54 u] 1,33

22.02,2007 15:29:01 u] 1,46

22.02,2007 15:29:03 u} 1,29

22.02,2007 15:29:14 u} 1,37 B

< | V7

For further information about the parameters window, please see the chapter Parameters.

1....2....3. ...

Names of the last database files opened for quick reload.
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Data Directory

Opens the explorer with the current data directory to copy or rename the data base. This is the same function as
in the start menu up to Windows 7.

Exit
Terminates the program.
EDIT MENU

This menu contains commands to copy data/graphics from bbe++ and add them to the clipboard.

Edit Parameters  Wiew W
Copy Chrl+iC

Edit Comment
Delete Data

Copy

The content of the active window will be copied to the clipboard. Depending on the type of the active window,
this is either a graph or a table.

Tables can be pasted to EXCEL directly.

How to copy data to EXCEL:

Use “WINDOW - SELECT DATA” to select the data you want to copy to EXCEL. Use the list window type that
contains all the columns to be exported. Please note: only the columns from the active view are exported.

[ bbe ++.bdb [FP-18-03] :1 - O] %]
Date/Time [date] Conc 0 [Gresn Algae] [pgf1] | Conc 1 [Bluegreen] [pgd] | Conc 2 [Diatams] [pad] | Conc 3 [Cryptopheta] [pgd] | Ci
15.056.2009 09:10:50 a 0,813 a 0,495
15.06.2009 09:10:53 a 1,04 a a
15.06.2009 09:10:55 u] u] u] u]
15.06.2009 09:10:57 u] 2,28 u] u]
15.056.2009 09:11:00 1,08 0,829 a a
15.06.2009 09:11:02 a 0,142 a 2,09
15.06.2009 09:11:04 0,0475 0,956 u] 0,202
15.06.2009 09:11:07 u] 0,932 u] u]
15.06.2009 09:11:09 a 1,2 a a
15.06.2009 09:11:12 a 0,74 a a
15.06.2009 09:11:14 u] 0,561 u] 0,936
15.06.2009 09:11:16 u] 0,698 u] u]
15.06.2009 09:11:19 0,945 0,779 u] u]
15.06.2009 09:11:21 a 0,804 a a
15.06.2009 09:11:23 3,35 a a a
15.06.2009 09:11:26 1,07 0,482 u] u]
15.06.2009 09:11:28 u] 0,261 u] 2,03
15.06.2009 09:11:31 1,52 0,227 a a
15.06.2009 09:11:33 a 1,1 a a
15.06.2009 09:11:35 u] 1,58 u] 1,97
15.06.2009 09:11:38 341 u] u] 0,883
15.056.2009 09:11:40 3,26 a 2,18 a
15.06.2009 09:11:42 0,792 a 2,82 a -
1] | .z

e click on “EDIT > CoPY”
e open Excel with an empty datasheet

e click on “EDIT = PASTE” in Excel
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i 1 N L I —i — |
B7 | =| 108
A | B | C | D | E | ;“
| 1 |DatefTime Conc 0 [Green Algae] Cone 1 [Bluegreen] Conc 2 [Diatoms] Cone 3 [Cryptophyta] ©
| 2 |date Pl pdl pdl Pl iTe]
| 3 [15.06.2009 09:10 0 05813 0
| 4 |[15.06.2009 09:10 0 1,04 0
| 5 |15.06.2009 09:10 a0 a0 a0
| 6 |15.06.2009 09:10 i 228 0
| 7 | 15.06.2009 09:11 1,081 0,529 1]
| 8 | 15.06.2009 09:11 ] 0,142 1]
| 9 |15.06.200% 09:11 0,0475 0,956 ]
| 10| 15.06.2002 09:11 0 0532 0
| 11 | 15.06.2009 09:11 0 12 0
| 12 | 15.06.2009 09:11 a0 0,74 a0
| 13 | 15.06.2005 09:11 0 0561 0
| 14 | 15.06.2009 02:11 1] 0655 1]
| 15| 15.06.2009 02:11 0945 0,779 1]
| 16 | 15.06.200% 09:11 ] 0,504 ]
| 17 | 15.06.2002 09:11 335 ] ]
| 18 | 15.06.2009 09:11 1.07 0,485 0
| 19| 15.06.2009 09:11 a0 0,261 a0
| 20 | 15.06.2005 09:11 1,52 0227 0
| 21 | 15.06.2009 09:11 1] 11 1]
| 22 | 15.06.2009 02:11 1] 1,58 1]
| 23 | 15.06.200% 02:11 50 ] ]
| 24 | 15.06.2009 09:11 326 ] 2,18
| 25 | 15.06.2009 09:11 0,792 0 282
| 26 | 15.06.2009 09:11 282 a0 1,33
| 27 | 15.06.2009 09:11 fF5 a0 a0
| 28 | 15.06.2005 09:11 B 5B 0 0539
| 29 | 15.06.2009 02:11 1] 0,11 1,16
| 30 | 15.06.2009 09:11 1] 0,363 1]
3115 0R2NNS N9-11 44 il
14 [« » [p[\Tabelle1 / Tabelle? / Tabeled / |«

Now the data can be used for all kinds off calculations within Excel.

Edit Comment — advanced functionality only

To edit the comment of one or more datasets mark the datasets in the table view. A dataset can be marked with
a mouse click. Multiple datasets can be marked be pressing Ctrl key while clicking on the dataset required.

EJbbe + + - New.bdb [FP-17-09] =10l

File Edit Parameters Wiew ‘Window Tools Calibration Help

ST
Set air Edit
Get data
Start Stop ‘ pressure parameters
[ Mew.bdb [FP-17-09] -0 x|
DakejTime [date] I Cormment I Green Algae [ug/l] I EBluegreen [ugfl] I Diakoms [pgjl] | Cryprophvta [Lafl] | #5 [pg)l] | ‘ellow substances [pgfl] | Total conc. [ug/l] | :l
27.12.2011 0&:41:23 0,33 1,87 0,00 0,00 0,00 0,00 2,20 —
27.12,2011 06:41:24 0,06 1,58 0,51 0,00 0,00 0,00 2,14
0,07 1,59 0,00 1,65

27.12.2011 08:41:50 0,00 0,00 0,00 2,26 0,00 0,00 2,26
27.12,2011 O:41:51 0,00 0,00 0,00 4,87 0,00 0,00 4,87
27.12,2011 08:41:57 0,11 0,00 2,64 0,46 0,00 0,00 3,21
27.12,2011 03:41:58 0,24 0,00 2,67 0,13 0,00 0,27 3,04
27.12,2011 08:41:59 1,34 0,00 2,64 0,00 0,00 0,00 3,98
27.12,2011 03:41:59 0,00 0,68 3,78 0,00 0,00 0,09 4,46
27.12.2011 08:41:59 1,23 0,00 1,60 1,23 0,00 0,00 4,05
27.12.2011 0&:42:00 2,90 0,00 1,36 0,00 0,00 0,09 4,26
27.12,2011 0§:42:00 0,95 0,00 2,92 0,14 0,00 0,14 4,01
27.12,2011 03:42:01 0,38 0,00 3,08 0,00 0,00 0,51 3,46
27.12,2011 03:42:01 0,48 0,00 3,57 0,00 0,00 0,00 4,05
27.12,2011 03:42:01 1,63 0,00 2,79 0,00 0,00 0,00 4,43
27.12.2011 08:42:02 0,71 0,00 3,36 0,36 0,00 0,00 4,43
27.12.2011 0&:42:02 1,51 0,00 3,02 0,00 0,00 0,00 4,54
27.12,2011 08:42:03 1,53 0,00 z,92 0,00 0,00 0,21 445 -

1 | ;l_/l

Ready [ o [
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Go to Edit > Edit comments or use right click on the marked datasets:

0,07 1,59

Histary of Parameters

Edit Comment
Delete Data
Data Fields Selection

0,00 0,00

0,00 0,00
0,11 0,00

Enter the new comment for the selected data:

New.bdb [FP-17-09] =1alxl
Date/Time [date] I Comment I Green Algae [pgfl] | Eluegreen [pg/fl] | Diakoms [pgjl] | Cryptaphyta [pgfl] | #5 [pgfl] | ‘ellow substances [pgfl] | Tatal conc. [pgfl] | Transmissior A|
27.12,2011 08:41:23 0,33 1,87 0,00 0,00 0,00 0,00 2,20 :
27.12,2011 08:41:24 0,06 1,58 0,51 0,00 0,00 0,00 Z,14 E
27.12,2011 08:4 0,07 1,59 0,00 0,00 0,00 0,00 1,65 E
27.12.2011 08:4 0,00 1,66 0,00 0,00 0,00 0,00 1,66 1
27.12,2011 08:41:29 0,00 2,37 0,00 0,00 0,00 0,20 2,37 4
27.12,2011 08:4 0,91 1,69 0,02 0,00 0,00 0,00 2,62 4
27.12,2011 08:4 0,00 0,00 0,38 0,82 0,00 0,00 1,20 [
27122011 08:41:36 0,00 0,25 0,00 0,00 0,00 1,47 0,25 1C
27.12.2011 03:4 E
27.12,2011 08:41: [ Tite (e [ Test | 1
27.12,2011 0&:41; Comment | Test E
27122011 0&:4 iC
27.12,2011 08:41: 1C
27.12.2011 08:41: iC
27.12.2011 08:4 Cans! | 1
27.12,2011 08:41: iC
27.12,2011 08:42; 2,90 0,00 1,36 0,00 0,00 0,09 4,26 1
27.12,2011 0&:4 0,95 0,00 2,92 0,14 0,00 0,14 4,01 1
27.12,2011 08:42: 0,38 0,00 3,08 0,00 0,00 0,51 3,46 1C
27.12.2011 08:42: 0,48 0,00 3,57 0,00 0,00 0,00 4,05 1
27.12,2011 08:4 1,63 0,00 2,79 0,00 0,00 0,00 4,43 1
27.12,2011 08:4 0,71 0,00 3,36 0,36 0,00 0,00 4,43 1
27.12,2011 08142 1,51 0,00 3,02 0,00 0,00 0,00 4,54 1
27.12,2011 08:42:03 1,53 0,00 2,92 0,00 0,00 0,21 4,45 10
4 | oW
Click OK:
i
Date Time [date] I Comment I Green Algae [ug/l] | Bluegreen [ug/l] | Diakams [Lg/fl] | Cryphophyta [ug)l] | #5 [ug)l] | ‘ellow substances [pag/l] | Tokal conc. [Lg/l] | :l
27.12,2011 06:41:23 0,33 1,87 0,00 0,00 0,00 0,00 2,20 -
27.12,2011 05:41:24 0,06 1,58 0,51 0,00 0,00 0,00 2,14
27.12,2011 05:41:24 0,07 1,59 0,00 0,00 0,00 0,00 1,65
27.12.2011 08:41:26  This is the new comm... 0,00 1,66 0,00 0,00 0,00 0,00 1,66
27.12,2011 08:41:29  This is the new comm... 0,00 2,37 0,00 0,00 0,00 0,20 2,37
27.12,2011 08:41:30  This is the new comm. 0,91 1,69 0,02 0,00 0,00 0,00 2,62
27.12,2011 08:41:34  This is the new comm... 0,00 0,00 0,38 0,82 0,00 0,00 1,20
27.12.2011 08:41:36  This is the new camm... 0,00 0,25 0,00 0,00 0,00 1,47 0,25
27.12,2011 05:41:39  This is the nevs comm., 0,00 0,62 0,00 1,29 0,00 0,00 1,91
27.12,2011 08:41:41  This is the nev comm... 0,00 3,86 0,00 1,24 0,00 0,57 5,10
27.12,2011 05:41:50 0,00 0,00 0,00 2,26 0,00 0,00 2,26
27.12.2011 08:41:51 0,00 0,00 0,00 4,87 0,00 0,00 4,87
27.12.2011 08:41:57 0,11 0,00 2,64 0,46 0,00 0,00 3,21
27.12,2011 06:41:58 0,24 0,00 2,67 0,13 0,00 0,27 3,04
27.12,2011 05:41:59 1,34 0,00 2,64 0,00 0,00 0,00 3,98
27.12,2011 05:41:59 0,00 0,68 3,78 0,00 0,00 0,09 4,46
27.12.2011 08:41:59 1,23 0,00 1,60 1,23 0,00 0,00 4,05
27.12,2011 0&:42;:00 2,90 0,00 1,38 0,00 0,00 0,09 4,26
27.12,2011 D&:42:00 0,95 0,00 2,92 0,14 0,00 0,14 4,01
27.12,2011 05:42:01 0,38 0,00 3,08 0,00 0,00 0,51 3,46
27.12.2011 08:42:01 0,48 0,00 3,57 0,00 0,00 0,00 4,05
27.12,2011 0&:42:01 1,63 0,00 2,79 0,00 0,00 0,00 4,43
27.12,2011 06:42;:02 0,71 0,00 3,360 0,36 0,00 0,00 4,43
27.12,2011 D5:42:02 1,51 0,00 3,02 0,00 0,00 0,00 4,54
27.12.2011 08:42:03 1,53 0,00 2,92 0,00 0,00 0,21 4,45 o
| | _’l_él

Delete Data — advanced functionality only

To delete data, mark the datasets as described above.
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Go to “EDIT > DELETE DATA” or use right click on the marked datasets:

0,07 1,59

Hisl ary ar Farameters
Edit Comment
Delete Data

Data Fields Selection

Click OK to delete the data.

x
‘You have marked 7 out of 962 data sets.

Flease choose which data sets to delste.

& Delete marked data sets only

" Delete all data sets

oK | Cancel |

PARAMETERS MENU

Parameters | View Window Tools Calibi
History
Templates
Online
Recalc
Parameterset 4 Standard
Warkstation
Item Function Available for
. Display parameters of datasets stored in the .
History piay p All instruments
database
Apply a user-defined selection of parameters
Template PPy P All but AlgaeTorch and BenthoTorch

to an instrument

Display and change parameters in the

Online .
instruments

All but AlgaeTorch and BenthoTorch

Recalc Recalculate the d_atasgts in the database with All but AlgaeTorch and BenthoTorch
another set of calibration parameters

Select a parameter set from the ones stored in

Parameterset the instrument — see description below.

FluoroProbe with parameter sets

The first 4 selections in the menu lead to one tab of the Parameters window.

Please note:

Only parameters of the current type of instrument are shown.

It depends on the user level, whether a parameter is shown or not. The higher the user level, the
more parameters are shown.
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For example of parameter listings for user levels, please see the examples below.

Access level “advanced functionality”:

Parameters

[evice parameters

Farameters can be edited and copied to the clipboard.
Changed parameters will be gent ta the device when you close this window by
uzing the "OK" button,

I atri:

x|

| cipboard |

Creation date of parameter zet |29_1 22011 15:08:00

~| Online

Frocess p b Comrman p b | Fit p b I Meazurement p b I Turbidity p f I
Mame | Valuel Lnit |
W arm-up time 8z

+ Measurement interval 0 s

" Mumber of measurements 1

+ LED measzuring time 20 1/10s

" Measurement time: 200 1410z

" Send results an

" Power-down after measurement off

" Store results an

“ Start measurement on power-up off

" Calculate concentrations after each measurement off

& Serial nurmber 1709

@ Software version 227

0K, I Abbrechen [Ibernehmen

Access level “User”:

Parameters

[evice parameters

Farameters can be edited and copied to the clipboard.
Changed parameters will be gent ta the device when you close this window by
uzing the "OK" button,

[ iz

x|

| Ccipboard |

Creation date of parameter zet |D2_D1 20211:22:25

~| Online

Frocess p b Comrman p b | Fit p b I Turbidity parameters I

Mame | Valuel Lnit |
" Measurement interval 0 s

+ LED measzuring time 20 1/10s

" Measurement time: 200 1410z

" Power-down after measurement off

“ Start measurement on power-up off

" Calculate concentrations after each measurement off

& Serial number 1709

& Software version 227

oK I Abbrechenl Ul_:emehmenl

Depending on the parameters and on the access level, the parameters are read only |¢ or read and write .
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Overview

Type of operation |

| Type of Parameter

Explanations
Name / Date of the parameter set
x|

- Hiskary / - -
Templates Fecalculation with changed parameters. Create copy | Delete |
online Create an editable parameter set by uging "Creafe copy''. Fecalo | Unda |

Start recalcualtion by "Recals".

Restore onginal results by using "'UAdo™, Mati

Calculation will effect all data curgently in thé view. atnix

Creation date of paramebér set |D2_D1_2D‘]2 11:20:27 [Test] j Adapted
Process parameters  Cpmman parameters | Fit parameter&l Meazurement parameters ¥ Turbidity par eter&l
M arne / | W alLe }/Unit l |

/

Warm-up ime
Measurement interval
MHurmber of meazurements
LED meazuring time
Meazurement time

200 1108
200 1410s
ah
off
ah
off
off
1704
227

/ / oK. I Abbrec'l\enl [Eermehmmen
I

-/

Command buttons Type of parameter set

Send resultz

Power-down after measurement

Store resultz

Start measurement on power-up

Calculate concentrations after each measuremen
& Serial number
& Software version

Values

Type of operation

The selection of the type of operation corresponds to the commands in the menu. Depending on the selection,
different types of operations can be done.

Explanations
Gives a short introduction to what can be done.

Buttons
Export: exports the current parameter set to another database for recalculation

Clipboard: copies the current parameter set to the clipboard to paste it into another application such as Office
Word or Excel etc.

Upload: sends the parameters to the connected instrument

Matrix: shows all the calibration parameters of the connected instrument in one window.

Name of parameter set

Each set of parameters can be identified by its time and date. Edited parameter sets or templates have an
additional name given by the user.
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Type of parameter

Each tab shows the parameters of a specific topic.

Values

Shows the current values of the parameters. Depending on the type of operation the value can be edited.

Type of parameter set

Indicates the type of parameter set:
Original: this parameter set has been used originally for a measurement, it cannot be deleted.

Adapted: this is a parameter set has been adapted by the user, it can be used to recalculate the datasets.

Shows the current values of the parameters. Depending on the type of operation the value can be edited.

History — advanced functionality only

Displays the parameters of the active dataset.

The history is also available on the Context Menu in table view:

[ New.bdb [FP-17-09] :1

Date|Time [date] Commenk | Greer
27.12.2011 08:41:23
27.12.2011 05:41:24
27.12.2011 03:41:24

Hiskory of Parameters
27.12.20:

2712501 Edit Comment
2?' 12'20: Delete Data

" Data Fields Selection
271220

£7.12.2011 03:41:59
£7.12.2011 03:41:59
27.12.2011 03:42:00
27. 12,2011 05:42:00
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All parameter sets in the database can be displayed. To choose one parameter set, select the date from the
drop-down box:

Creation date of parameter zet | 2604 2011 15:24:1 ~| Ori
R e
ncess parameters | Commaon par 10.08.2011 135930 parar
10.08.2011 14:03:34
Jame 10.08.2011 14:09.04

‘mter comment at start of measure 20.09.2017 12:34:59 [Twibidity compenation]
it pressure from first measuremen| 09.10.2011 15:27:37 [Turbidity plato)
057102011 15:35:07 [Turbidity plata]
12102011 11:25:58

12102011 120551

121020011 1211:0m

121020011 12:20:07

12102001 1226:38

Template Button

The ,Template® button is used to generate a new template from the current parameter set using different
schemes. A scheme is a predefined selection of parameter — for example all the fingerprints. The parameter of
the selection will be copied to a new template. Parameters that are not in the scheme will not be copied.

This is more convenient, than entering the parameter to a new template by hand.
The new template can be edited as any template.

First step is to choose the scheme with the selection of parameters.
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Giving the new template a name:

Afterwards the new template can be displayed and edited. It can be used as any other template.
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Templates

The purpose of parameter templates is to store a partial set of parameters (for example offsets or measuring
times or air pressure handling) in one set. This makes it easy to apply different setting to an instrument,
depending on the location.

Create a new template

Click new, all parameters of the current user-level are shown and empty. To change an entry, double click on
the value box. When entering the first value, a name for the parameter set is requested:

Mame of Parameter Template x|

To diztinguizh parameter templates pou can aszigh
here an ophional name.

IM_I,I rews bemplate]

Cancel |

The name and date is shown in the headline of the table:

Creation date of parameter IIZIEI_1 1.2017 14:58:35 [My new template) j

iz parameters  Common parameters | Fit parametersl teazurement parametersl Turbidity pararr

3 | " allie | Init

Depending on the type of parameter, either an input box or a drop-down box is used:
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Mame ot class b
Mame of class 7
LED meazurement interyal | || E

P e g e

E nabled far fit flag class &

Enahled far fit flag class B j
Enabled for fit flag class 7 aff
Are vellow Substances clazz 0 on

Are vellow Substances clazs 1
Click OK to store the template.

Upload a template
1. connect the instrument to the PC (“TooLs > CONNECT COM PORT”)

2. go to “PARAMETER-> TEMPLATES"

3. select the template from the drop-down box:

Creation date of parameter [09.11.2011 15:14:53 [My second template) j
09.11.20171 14:58:35 [My new template
Process parameters I Tl 09.171.2011 15:14:53 [My second template]

M ame | "v"aluel Uit

4. Click “UPLOAD"

bbe++ loads all the parameters from the instrument:

Parameter impork ﬂ

Irmporting...

Cancel

and sends the changed parameters back to the instrument.

Parameter transfer ﬂ

Syncing parameters. ..

Cancel

All parameters not defined in the template will not be overwritten in the instrument.

Delete a template

e select the template to be deleted

e click delete
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Online
The section “Online” is used to change the parameters of the instrument.
This item is available as soon as an instrument is connected.
1. connect the instrument to the PC (“TooLs > CONNECT COM PORT”)
2. go to “PARAMETERS = ONLINE”

bbe++ loads all the parameters from the instrument:

Parameter impork ﬂ

Importing...

Cancel

The parameters are shown:

3. change the parameters as described in the “Template” section.
4. click OK to upload the new parameters

5. Use the “clipboard” button to copy all the parameters to the clipboard and paste it into EXCEL for
example:
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A
Date: 09.11.2011 15:52:32
Device: FP-17-09

Process parameters

MName
Enter comment at start of measurement

WO~ e e W e

Air pressure from first measurement

Bl
M=o

Common parameters

=8

Name

&

Measurement interval

[
=1

LED measuring time
Measurement time

|
e |~

Power-down after measurement
Start measurement on power-up
Serial number

[ -
L= =]

Software version

[
LR

24 Fit parameters
25
26 Name
27 Enabled for fit flag Green Algae
28 Enabled for fit flag Bluegreen
29 Enabled for fit flag Diatoms
30 Enabled for fit flag Cryptophyta
31 Enabled for fit flag sdsds#4
32 Enabled for fit flag #5
33 Enabled for fit flag #6
34 Enabled for fit flag Yellow substances
35 Date of calibration
55|
37
38 Turbidity parameters
39
40 Name
41 | Turbitidy compensation

Value
on
off

Value

20
20
off
off
1709
227

Value
on
on
on
on

off
off
off
on
21.11.2007

Value
off

uUnit

Unit

1/10s
1/10s

Unit

Unit
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Recalc — advanced functionality only

The recalculation option is available in all instruments except for the AlgaeTorch. For the BenthoTorch the
recalculation is limited to the recalculation by using another parameter set from the BenthoTorch. Editing of the
parameter sets and templates are not available for the BenthoTorch.

To change the settings and recalculate the results, the following steps have to be executed:
1. Select the instrument and time period (“WINDOW > SELECT DATA”).
2. Go to “PARAMETERS > RECALC”

3. Select a new dataset from the dropdown box or create a new one by editing a copy. Please note: only copies
of an original parameter set can be edited. These sets are marked with “adapted”.
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4. To create a new parameter set (not in the BenthoTorch), select one, click “CREATE COPY” and enter a name
for this parameter set.

Name of Parameter Sek il

To digtinguizh parameter sets you can assign here
an optional hame.

IM_I,I adapted parameter jzet

Cancel |

I'IEI.EIB.2E|11 14:03:34 j

110.08.2011 13558:30
410.08.2011 140334
110082011 14:09:04
420.09.2017 12:34:53 [Turbidity compenation)]
051020171 15: 2737 [Tuwrbidity plata)

051002011 15:35:07 [Turbidity plata)

12102011 11:25:58

12102011 12:05:51

12102011 12:11:01

112.10.2011 12:20:07

112102011 12:26:38

10.11.2011 08:58:04 [My adapted parameter zet]

5. Select the new parameter set and edit the settings as described in the “Template” section. Please note the
number and type of parameters shown depends on the user-level. Only the parameters marked with the
green symbol can be changed.
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Parameters

Fi ecalculation with changed parameters.

Create an editable parameter set by uzsing ''"Create copy'’.
i Recalc Start recalcualtion by "Recalc!.

Fi estore original results by using “Unda".

Calculation will affect all data curently in the view.

Creation date of parameter set (PRl 34:59 [T urbidity compenation)

Frocess parameters | Common parameters Fitp b | Turbidity p

Create copy |

x|

Delete

Unda

~| Adapted

Mame |

Walue | Linit

Enabled for fit flag Green Algae

Enabled for fit flag Bluegreen

Enabled for fit flag Diatoms

Enabled for fit flag Cryptophyta

Enabled for fit flag #4

Enabled for fit flag #5

Enabled for fit flag #E

Enabled for fit flag vellow substances
& Date of calibration

an

on
on
on
off
off
off
on

] I Abbrechen

[bernehmen

6. Click “APpLY” to store the changes in the new parameter set.

7. Click “REcALC” to recalculate the data with the new parameters.

8. Recalculated data sets are marked in table view at the beginning of each line:

kel bbe + +.bdb [FP-19-01] :1
Dake) Time [date] Comment | Gr
f12.10.2011 11:25:14 a
le.lD.ZEIll 11:25:356

f12.10.2011 11:25:58

Restore data with original parameters

The original data of the measurement is not deleted by the recalculation. It is always possible to see the results

calculated with the parameters valid when the measurement was taken.

To restore the original data:

1. Select the instrument and time period (“WINDOW - SELECT DATA”)

2. Go to “PARAMETERS - RECALC”

3. Click “UNDO”. Please note: This item is only available when recalculated data are available in the selected

time period.
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Delete adapted parameter sets

To delete adapted parameter sets click “DELETE”. All unused parameter sets will be shown. Parameter sets that
are in use cannot be deleted.

Delete parameter set ﬂ

Pleaze zelect one or more parameter zets that you
wizh to delete.

Only parameter setz created by copy of an original

zet and not in uze for any recalculation are listed
ol

200920171 12:34:53 [Turbidity compenation)
05102011 15:27:37 [Turbidity plata)
10.11.2011 083242 [My adapted parameter set]

coc_|

Select the parameter sets to be deleted and click “DELETE”.

Matrix view

For the parameters of the FluoroProbe and the AlgaeLabAnalyser there is another window available to edit the
parameters. It is shown when the button “MATRIX” is pushed:

Changing any parameter here has the same effect as changing the parameter in the standard view.
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VIEW MENU

View | Window Tools Calibration Help

Toolbar
Status Bar

Measurement F10

Batch

Macro

Data navigation
Period

Session

Connection state

Auto-Update

Application Look 4

Windows 2000
Office XP
Windows XP
Office 2003
Wisual Studio 2005
[#] visual Studio 2008

Office 2007 L4

Blue Style
Black Style
Silver Style
Agua Style

Toolbar

Displays or hides the toolbar.

The toolbar allows quick access to some important instructions:

New database }-\
s

Open database ‘ \—{ Open the Settings dialog

‘ Copy graphic or table to clipboard

Status Bar

Displays or hides the status bar.

Ready | UM | 4

Measurement

Displays / hides the measurement toolbar.

The toolbar “Measurement” is different for each type of instrument. It allows quick access to functions such as
starting and stopping the measurement or retrieving the parameters.

The measurement toolbar of the FluoroProbe is given here as an example:

Get data Edit

parameters

‘ Start ‘ Stl]p pressure

‘ Set air ‘
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Macro

The toolbar “Macro” contains buttons to access to the user-defined view macros. For details, please see the
chapter “TOOLS” = “SETTINGS” = “MACRO MANAGER”.

102 (3

For the grey buttons, no macro has been defined.

Data Navigation

The toolbar “Data navigation” contains buttons to navigate within the data. “One page” corresponds to the time
scale of the Concentration vs. Time graphs.

H4 4 » MM

go to the first dataset
one page backwards

one page forwards

* & & o

go to the last dataset

Period

The toolbar “Period” contains buttons to scale the time axes to a given value:

1h 6h 1d 7d

1 hour
6 hours

1 day

* & o o

7 days

Session

The toolbar “Session” contains buttons to navigate from one measurement to another. One measurement is
defined as a number of consecutive data sets that do not differ in the point of measurement by more than a
given value. This value can be set in “TOOLS” > “SETTINGS” - “DISPLAY”.

4 M

Connection State

The toolbar “Connection state” shows the status of the connection to the connected instrument:

o

The colour indicates the status:

Black: Not connected, the PC has not tried to establish a connection
Yellow, blinking: Not connected, the PC is trying to establish a connection
Green: Connected
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To open the COM port setting click the coneection state button

Auto-Update

If auto-update is activated and a new data-set is generated during the measurement, this data-set is shown in
the graphic or list window. If the displayed period does not contain this current point in time, the displayed period
is changed automatically, so that the latest data-set is shown.

If auto-update is deactivated, the displayed period does not change. This is useful when doing data analysis
during the measurement.

Application look

Changes the style of the application

Window — Advanced functionality only

This menu contains commands to show, arrange and edit different views to display the data.

window Tools  Calbration H

Mewvs Table Window 4
Tew ¥¥Graph Window 3
Single Yalue 3
Cascade

Tile Hotizontally

Tile Vertically

Select Data
Summary Yiew

Wigw Editor
Comment Figlds

1 Mew,bdb [FP-17-09] :1
v 2 Mew.bdb [FP-17-09] :2
3 Mew.bdb [FP-17-09] :3

New Table Window

Opens a new window and displays the data according to the selected window type.

Mew Table Window

Default
3 Cell count
Simala Walie 3

Mew XyYiGraph Window

(See below)

Please see the list window “Concentration” of an AlgaeTorch as an example.

bbe++.bdb [AT-04-002] 4

o] x|

Date/Time [date] | Cyano [pg!l]l Conc Total [pgjl]l Turbidity [FTLY] |

Depth [

07.04.2010 11:33:33 36,1 77,5 0
07.04.2010 11:33:47 35,8 76,9 0
07.04.2010 11:34:02 35,8 76,9 0

|

| B

New XYGraph Window

Opens a new window and displays the data according to the selected window type.
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Mew #¥Graph Window 4 Conc. [ time

Single Yalue 3 Cell count: § kime
Transmission | Time
Conc. [ depth

Cell count [ depth
Wigw Edikor Transmission | Depth

Select Data
Summary Wiew

There are some view types pre-defined for each instrument. It is also possible to add new window types by
using the view editor.

The following diagram shows the development of different algae classes measured with the bbe FluoroProbe.

Bbbe + +.bdb [FP-18-03] :3 =10l x|

Time vs. Concentration
[l conc 0 [Green Algae] [l Conc 1 [Bluegreen] [l Conc 2 [Diatoms] [l Conc 3 [Cryptophyta] || Conc 4 [#4] || Conc 5 [45] | Conc 6 [#6]  Conc 7 [Yellow substances] ] Conc Total

New Single Value View

Opens a new window and displays the data of one data-set according to the selected window type.

WIGGETN Tools  Calibration  Help
v Mew Table Window 4
Mew 1Y Graph Window L3 T

Single Yalue Drefault

Cell count r

Cascade ) _
= . . Takal concentration =
Tile Horizontally
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The data-set is shown in larger digits to help the user read the display even in bright sunlight. The latest data-

set is shown.

E& bbe++.bdb [FP-17-09] :4

Date/Time [date]
22.08.2012

10:41:51

Green Algas [l

0,00

Eluegreen ||

0,00

Mg/

Diatoms [gd]

0,32

Cryptophyta [ugf]

1,99

Yellow substances [g]

1,32

Total conc. [ug!]

1,91

Transmission [%)

100,00

Depth [m

38, 27

Temp. Sample [*C]

6,15

The “Single Value View” can be adapted to the screen by changing size and/or proportion of the window:

]
Deeiime [eie] Green Algae g/l e
Zemi 10,00
Bluegreen [1g/] Diatorns [Lg/] 0.00
0,00 0,32
Cryptophyta [ugfl] Yellow substances [ugi] 159 .
1,59 1,32
Total conc. [ug] Transmission (%] 191[]
1,91 100,00 e
Depth [m Temp. Sample [°C] Ea
38,27 6,15

B bbe-+.bdb [FP-17-09] :4

DateTirme [date] Green Algae [Woil] Bluegreen [po/l] Diatams [uail] Cryptophyta (o]

Tt 0,00 0,00 0,32 1,59

Yellow substances [poil] Tatal cone. [pal] Transrission [%] Depth [rn] Temp. Sample [C]

1,32 1,91 100,00 38,27 6,15
Cascade

Arranges the windows one behind the other.
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Tile Horizontally/Vertically

Initiates the organization of the screen into mutually non-overlapping frames.

Select Data

The “Select Data” window can be used to select data of a specific instrument and a specific time range from the

current database.

Select data Ei|W Select data X|
Type IAIgaeTorch ;I Type IAIgaeTorch -
FluoroProbe
Unit |AT-04-002 =] Unit [AT-04-002 -
— Time range — Time range
IIast day ;I IIast day LI
| =
From |u?.u4.2mn = Fram |n?_04.2mn ==
To |u?.u4.2mn = To |n?_04.2mn =
Cancel | oK I Cancel |
Type: shows the types of instruments available in this database.
Unit: shows the serial numbers of the type of instruments chosen above available in this

database.

Time range

Selects the time range of data to be selected. It is possible to select a fixed time range such as “last month” or
to do a manual selection by entering a range FRoOM “date” To “date”.

Hint: Further selections can also easily be made in a graphic window.

Time range

|Iast day j

From |15.06.2012 =

To |25[H.2012 =
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After selecting the time range, the data is shown in the default view.

[ bbe + +.bdb [FP-15-02] =10] ]

Date/Time [date] Conc 0 [Green Algae] [pg/l] Conc 1 [Bluegreen] [pgfl] | Conc 2 [Diatoms] [~
22.02.2007 15:27:25 u] 1,34
22.02.2007 15:27:34 u] 1,43
22.02.2007 15:27:40 u] 1,41
22.02,2007 15:27:47 u] 1,37
22.02,2007 15:27:33 u] 1,45
22.02,2007 15:28:00 u] 1,4
22.02,2007 15:28:06 u] 1,34
22.02,2007 15:28:13 u] 1,35
22.02,2007 15:28:20 u] 1,38

u]

u]

u]

u]

u]

u]

u]

u]

22.02.2007 15:28:26 1,42
22.02.2007 15:28:35 1,3
22.02.2007 15:25:41 1,47

22.02.2007 15:28:48 1,4

22.02.2007 15:28:54 1,23

22.02.2007 15:29:01 1,46

22.02.2007 15:29:08 1,29

22.02.2007 15:29:14 1,37 L

| | | o
View Editor

The View Editor is used to generate your own table or graphic window type as well as a template for the export
to text files. The View Editor is an assistant that leads through the whole process.

When starting the View Editor, the current view is selected automatically to be edited or used as a template for a
new view. Other views may be selected.

For each instrument there are pre-defined views. These views can be edited but not deleted. Changes in pre-
defined views can be reset to their original status. User-defined views can be edited and deleted.

Generating and editing a table view window

To explain the function of the View Editor, in the following steps a table view showing date/time, total chlorophyll
concentration, Bluegreen concentration and depth is generated as an example.

View Selection
1. Open the view editor:

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”).
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3. Choose the type of view that is to be generated or edited (in the example “Table view / single value

view”).

4. Choose one existing view to edit or as a template for a new one.

In case of a pre-defined view, the view can be reset to the original status (“RESET").

In case of a user-defined view, the view can be deleted (choose a custom view and click “DELETE”).

5. Click “NEXT”".

Field Configuration

This window shows all available data of the selected instrument. The left column shows the data that is currently
not used in the chosen view. In the right column are data that will be displayed in the resulting view. The order in
the right column corresponds to the order in the table.

Field Selection

X

Table is sorted according to first entry

Fields
Available

Comment [4] "
Comment [5]
Comment [6]
Comment [7]
Comment [8]
Comment [9]
Comment [10]
Comment [11]
Commenrt [12]
Comment [13] =

— L1

m

ili

Add -

<- Remaove

p

Diowen

Selected

Diate/Time [date] -
Sensortemp. [C]

Commert o
Total conc. [ugA]

activity Green Algae [

Digtoms [pg-1]
Cryptophyta [pg.1]
Yellow substances [wo/1] -

Pilola_sl =, T

< Zunick | Weiter = | Abbrechen

6. Click on “Green Algae [ug/l]” and “&< REMOVE” to remove the concentration of green algae from the

view.

Repeat with all entries but “Date/Time (date)”; “Bluegreen [ug/I]”, “Total conc. [ug/l]” and “Depth [m]”.

8. Click on “Total conc. [ug/l]” and "UP” to change the order.

Field Selection

L X

Table is sorted according to first entry

Fields
Available

LED 7 (Trans) [550 nm] [dig »
LED 8 (Trans) [470 nm] [dig
Sensortemp. [C] |

Green Ngr]ae ﬁ;"l —

Cryptophyta [pa.1]
Planktothrix [ugA]

#5 [ugA]

HE [ugA]

Yellow substances [pg/]  «

T

Add ->

<- Remove

P

i

Dowin

Selected

Date/Time [date]
Total conc. [ug

< funick | Weiter > Abbrechen
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9. Click “Next”.

General Properties

The General Properties page allows the user to change the background color of a “Single value” view.

10. Click on the color picker box behind ,Background color® and choose a new color.

a'
o
m

i

(0]
c
3
=R
w
=2
@

o
1
1
.
]

EEENE T
EEEENT
EEEEEN
EEEEN
TEEEENE
EEEENT
THEEEN

Benutzerdefinierte Farben:

rrrrr
T rrrr

Farben definieren =

—
—

171

ok | Abbre-:hen|

The chosen color is now shown in the color picker box
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Example of a change in background color:

Date/Time [date]
22.08.2012
10:41:52

Total cone. [ug/]
1,91
Bluegreen [g/]
0,00

Depth [m]

38,2

Save View
11. Enter a name for the view.
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12. Click “OK” to confirm. The current data is then shown with the new view.

13. The new view is now available in the Window menu.

WTDDIS Calibration  Help

H Mew Table Window
Mew Xiaraph Window 3
Single Yalue 3
Cascade
m Tile: Horizonkally
o Tile vertically
G
Select Data
39 .
Summary View
il
jal Wiew Editor
4 Comment Fields
:g 1 bbe++ bdb [FP-17-08] :1
- 2 bbe++.bdb [FP-17-09] :2
35 v 3 bbe++.bdb [FP-17-09] :3
3 S e

Default
Cell count

Total concentration Edit

| | | k rameters

I

| Diatarns [pgfl] | Cryptaophyta [pgf1] | e
0,00 0,00
0,51 0,00
0,00 0,00
0,00 0,00
0,00 0,00
0,02 0,00
0,38 0,82
0,00 0,00
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Generating and editing a graphic view window

To explain this function, in the following steps a graphic view showing date/time and total chlorophyll
concentration is generated as an example.

View Selection
1. Open the view editor:

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”).
Choose the type of view that is to be generated or edited (in the example “Graphics view”).
Choose one existing view to edit or as a template for a new one (in the example “Conc. / depth”).
In case of a pre-defined view, the view can be reset to the original status (“RESET”).
In case of a user-defined view, the custom view can be deleted (“DELETE”).

5. Click “NexT”.
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Independent Axis

6. Choose the design according to the given examples (in the example Y-Axis)

Field Configquration

7. Select the data for the axis chosen and click on “ADD->". Only one of the available entries is possible (in
the example “Depth”)
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8. After choosing one entry all other entries vanish. Removing the entry by clicking “<REMOVE” brings
back all available entries.

9. Click on ,PROPERTIES"

Axis Properties - first axis
Some properties can be set for each axis. For the first axis, this is the position and the direction.

Normally the first axis is on the lower or left side of the graph. The direction is normally defined as:
X-Axis: left side - low values right side - high values

Y-Axis: bottom - low values top - high values

To display e.g. chlorophyll concentration versus depth, it is easier to use the top position of the X-axis and to
invert the direction of the Y-axis for the depth. Please see the following example: the first picture shows the
standard settings, the second one with a direction-inverted Y-axis and inverted position of the X-axis.

Manual for the bbe AlgaeOnlineAnalyser Page 65



The Menus

bbe++.bdb [FP-17-09]:3

Conc. / depth connected
’GFEEH Algae ‘Bh.lEgl’EE" ’Diamms Cryptophyta ’YE”DW substances ‘Tula\ conc.
(22.08.2012 00:00:00 - 23.08.2012 00:00:00)

(=]
(=]
ey e ——————————-———-—;

5,00 pg/l

Conc. / depth connected 2
’Green Algae ’Bluegreen ’Diamms Cryptophyta ’\"E”DW substances ’Tmal conc.
(22.08.2012 00:00:00 - 23.08.2012 00:00:00)
2,00 3,00 5,00 pg/l
—_—

10,00

1

10. Click “OK” to confirm the settings.
11. Click “NEXT”.

12. Now the data and settings for the other axis can be selected.
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Field Configquration - second axis

13. After selecting one type of data, only those types which have the same unit(s) remain in the right
column.

14. For example, “Total chlorophyll concentration” and “Bluegreen” have to be selected here.
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Axis Properties - second axis
For the second axis, the properties can be set as shown above. Additionally available scaling options are:

Axis properties E|
Manual scaling Autozcale limits
Lowser limit
. [ Higher than
Min |0 i
[ Lower than
Upper limit
’7 [~ Higher th ’7
Wz [0 igher than 0

[~ Lower than

Scaling attributes
I Position inverted
[~ Direction inverted

v Autoscals on

Cancel

Manual scaling: enter fixed values for the minimum and the maximum of this axis - enter O for both to
disable this feature.

Auto-scale on: enables the auto-scaling feature - the axis will be scaled so that all selected data are
visible.

Auto-scale limits: these settings are used to obtain a nice looking graph in two special situations:

» datasets with very low noise:

In the auto-scaling mode, the graph looks as if there are extreme variations, but the
range is very small due to the auto-scaling. In this case, it is better to use the option:

lower limit: lower than and
upper limit: higher than
This leads to a minimum span in the graph.

» datasets with outliners:
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In this case, it is difficult to analyze the data because the auto-scaling generates a
high span value. To prevent this, please use:

lower limit:  higher than for outliners with low values and
upper limit: lower than for outliners with high values
This leads to an optimized span in the graph.
15. Click “Next”
Attributes
This sets the color and size of the dots and lines as well as the color of the background.

16. Set the value in the attributes window according to your needs.

Pixel number: enter the dot size of the value points.
Background color: click on the colored button to change the background color of the graph.

For illustration, please see the examples with connected and unconnected dots, different sizes and background
colors.

Different dot sizes:
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Different background colors:

Column Attributes

Select a dataset.

Color: select a dataset and click on the colored button to change the color of the dots.
Connected: check the box to connect the dots in the graph.

Hint: The data points are not connected if the time of measurement differs more than the given
value in “TOOLS 2 SETTINGS 2 DISPLAY”.

Different dot colors:
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Unconnected dots / connected dots:

17. Click “Next”
Save view

18. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on
a pre-defined view with a new name.

19. The current data is shown using the new view after clicking “OK”.

B bbe ++.bdb [AT-04-002] :2 N [u]

Raw data ws. time
I LED 0 [470] I LED 1 [610] LED 3[700] LED 2[525]
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Generating and editing an ASCII Export

View Selection
1. Open the view editor:

View selection X|

Urittype IAIgaeT orch =

Which kind of wiew do you wizh to
create or change?

= List view
7 Graphics visw
% fAgcil export

Export all
Export cellcounts

coos |

2. Choose the type of instrument the export is to be used for (in the example “AlgaeTorch”)

Choose the type of export that is to be generated or edited (in the example “ASCII export”)
Choose one existing view to edit or as a template for a new view. The delete button is used to delete a
view. It is not possible to delete pre-defined views.

5. Click “NEXT”

Field Confiquration
This window shows all available data of the selected instrument. The left column shows data which are not
currently used in the chosen view. In the right column are data that are to be displayed in the view. The order in

the right column corresponds to the order in the table.

Field configuration x|

 Field

DateTime
Crano

LED 0 [470]
LED 1 [E10]

Table is zorted by the Add -

first walue LED 2 [525] A Cone Tatal
LED 3 [700] SREmave || Tubidity
Temp. Sensor Depth
Ciount Cyana Up

Total cellcounts
Dawn

ddild

Frevious | M ext |

6. Select the required datasets from the right column. Use the up and down buttons to determine the order
of the data in the export table.

7. Click “Next”.
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Export attributes x|

Separator tabulator -
tabuilator

End of line semicalon

Export attributes x|

Separator Ilabulator - I

End of line

Presious |

windaws

] N |

8. Define separator and end of line characters according to the needs of the importing software.
9. Click “Next”.
Save View

10. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on
a pre-defined view with a new name.

x|

Prafile name: IEMpDrt CONG.

Previous |

11. The new view is now available in the “File” menu.

Expart (ASCIT) Export all
Export (database) Export conc.,

Comment Fields

For each type of instrument, special comments can be defined. These comment fields can be used at the
beginning of the measurement. The comments names and types can be defined within this dialog.

x
Device: IFIuoroPmbe j
Uzed | D ezcription | Type |A
wieather Text
Mame Text
Temperature Humber p
pH IT t *I
O Comment [5]
O Comment [5]
a Comment [7] Text
P er ||

Save a template |

cares_|

Type of instrument: the type of instrument is defined in the settings “TOOLS - SETTINGS - ACCESS".
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Used: if tagged, the comment can be used at the start of the measurement, otherwise the
comment is hidden.

Description: name of the comment

Type: “Text” allows entry of text, “Number” allows digits only; this is relevant for the way the

comments are sorted in a list view.

Template: stores the comment definition to transfer it to a new database; the transfer is done
when opening a new database.

1...2....3. ...

Shows all the currently opened windows.

TooLs

Menu (advanced functionality)

Tools | Calibration Help

Settings
Enable basic functionality

Connect COM port

Device 4

SQL Script

Menu (basic functionality)

Tools | Help

Settings

Enable advanced functionality

Settings
Here, all the preferences for the general functionality of bbe++ can be set.

Manual for the bbe AlgaeOnlineAnalyser Page 74



The Menus

Database

The ‘Database’ tab shows the currently used database. The checkbox can be used to open this database after
starting bbe++. We recommend you to store all the data in the same database.

Automatic start of measurement

For continuously working instruments (AOA or FluoroProbe / AlgaeTorch) the software can be configurated to
start the measurement directly after starting the software. The feature can be used to ensure, that the
measurement starts again after a power fail.

Auto Archive

If there are many datasets in the database, navigation in the database becomes slow. The “Auto Archive”
function automatically archives older data in the database. If there are data older than — in the example — 60
days, the auto-archive function is started. Only datasets that are a maximum of 30 days old remain in the
database.

The archived data is written in a database similar to an exported database. The name corresponds to the date
of the first dataset in this database.
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Display

Enter the time period which defines the maximum interval between two measurements of the same series. The
setting is used for the “Next measurement” button in the toolbar.

Next and previous measurement buttons in the toolbar.

4 M

Furthermore, this setting is used to control the drawing of lines between two dots. If the interval between two
measurements is shorter than the given interval, a line is drawn — otherwise not:

Bbbe + +.bdb [FP-18-03] :5

Conc. 5 time
Conc 0 [Green Algae] |§ Conc 1 [Bluegreen] [| Conc 2 [Diatoms] [| Conc 3 [Cryptophyta] Conc 7 [Yellow substances] ] Conc Total
9 9! ryptophyt

interval set to 10 minutes
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Bbbe + +.bdb [FP-18-03] :5

Conc. 5 time
ll Conc 0 [Green Algae] ] Conc 1 [Bluegreen] [ Conc 2 [Diatoms]

Conc 3 [Cryptophyta]  Conc 7 [Yellow substances] ] Conc Total

Access

Depending on the access level selected, the software shows more or fewer options. The main difference is the
number of items shown in the menus and the number of parameters shown.

If an instrument with editable parameters is connected, the same setting is maintained for editing.

Manual for the bbe AlgaeOnlineAnalyser Page 77



The Menus

User-levels:
Level Access
Basic functionality e Just basic operation of the instrument
e Measurements with pre-defined parameters only
Advanced e All menus accessible / all parameters customizable

functionality

The “Advanced functionality” level can be password-protected. As soon as the checkbox is ticked, a password
can be entered. Afterwards the password is required to enter the Advanced functionality level.

Please note:

The “Advanced functionality” level remains until “Basic functionality” level is chosen again.
Even when restarting the software, the “Advanced functionality” level and a given password
will still be valid.

Default Device

The bbe++ software is able to control different types bbe instruments, but only one type at one time. The type of
instrument is entered here. Various settings within the bbe++ software can only be made for the default type
instrument. To make entries for an other type of instrument, the default type has to be changed before.

Offline Mode:

Choose the offline mode to display data of different type of instruments. If the offline mode is active, no
measurement is possible.
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Macro manager

The bbe++ software provides the option to store the arrangement of the view windows. One of the stored views
can be used as the default view automatically displayed after starting bbe++.

1123

To generate a new view macro:
1. Arrange the windows.
2. Enter the name of the new view.
3. Check the “Use at program start” box as required.
4

Confirm.
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Logger settings

The logger settings are used in case of problems with the bbe++ software. Please ask the bbe service for
advice.

Depending on the checked options more or less information is stored in the file “error.log” in the program folder
of bbe++ software.

Shortcuts

With the F8 key, one single view can be retrieved. Please enter the single view macro to be used for this.
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F8 shows the selected macro

Language

This tab shows a list of the available languages of the bbe++ software. To change the language, choose the
language you wish and click “OK”. The bbe++ software must be restarted for the changes to take effect.
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IO moduls

This item is used to connect an 10 module (for example 4-20mA or relay outputs) to the PC.

e the COM port can either be chosen from the drop down box or the software can search all COM ports
for the selected instrument.

e once an instrument has been found the COM port is stored for the next use.

e To configurate the devices goto Tools -> device -> ... . This item is not available for all instruments.

With “search MCU” a multi channel unit for the AlgaeOnlineAnalyser can be conncted.
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Text results

This item is used to do the configuration of writing text files and sending data via RS232.

File output

If the file output is configured daily text files are written by bbe++. The files are stored in the path given in “file
path”.

The name is the serial number of the instrument date:
|| ALA-03-65_20170104.b¢t 04.01.2017 12:18 Textdokurment 1KB

The format of the output is defined by a “view” of the type “ASCII export”. For details please see the chapter
“view editor”. In the view editor the data columns and the format can be defined.

Files older than given in the “max. age of files” are deleted automatically. If this is set to “0” no files will be
deleted.

Enable advanced/basic functionality

Change between advanced and basic functionality. See also Tools -> Settings -> Access.

Connect COM port

COM-Port yerbinden x|

Cannection

R Search devicel

|Status: zearching for desvice

Cloze |
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This item is used to connect an instrument to the PC.

Please note:

e bbe++ is looking for an instrument of the selected type only (Tools - Settings > Access).

e the COM port can either be chosen from the drop down box or the software can search all COM ports
for the selected instrument.

e once an instrument has been found the COM port is stored for the next use.

Device

The “Device” submenu varies depending on the selected type of instrument. Each type has its own submenu.

DemoMode

To switch the bbe++ software to the demo mode select FluoroProbe (Tools -> Settings -> Access) and
disconnect all instruments. Click on “DEMO mode” in the device submenu. Now, the software can be operated
as if a FluoroProbe were connected. Some procedures such as calibrations are limited in function.

To reset the demo mode, please restart bbe++.

DEMO mode

) v Enter camment at skark of measurement
Sl Scripk

| | e
Delete data
i 0 [pgfl] I Conc 1 [ugfl]

Synchronize device with P Eime

Force import of all data

et data from device
fir pressure

AOA device Submenu

Enter comment at start of measurement:

Check to enter one or more comments when starting the measurement procedure.

Activity:
Check to perform activity measurements. If unchecked the activity measurement will be skipped.
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Continuous:

Check to perform continuous measurements (standard). If unchecked, only one measurement will be done. This
can be used for lab operation.

Test cleaning:
A cleaning procedure can be triggered.

Up/down:

Starts the cleaning piston to move up or down. The travelling time is indicated (normally around 20s)

Test pump:
The pump can be operated manually.

The test pump dialogue can also be used to check the required pumping time to get fresh sample to the
instrument.

Analog output (option):

The analog outputs can be configured according to individual needs. The outputs can be used for different
parameters and the range for the results can be set for 4-20 mA.

Additionally the sample source can be filtered:

None: All data of the chosen parameter will be applied, in depended from the sample source

Source n: Only data of the sample source n will be applied.

Depending on the number of installed analogue outputs more or less tabs will be displayed. In the screenshot
below 8 analogue outputs are installed.
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In this example, on channel 1, 4 mA is supplied at a chorophyll concentration of 0 ug/l and 20mA at a
concentration of 100 ug/l — for any sample source. Values that are above or underneath these are converted to
20 respectively 4mA.

On channel 2, 4 mA is supplied at a chorophyll concentration of 0 ug/l and 20mA at a concentration of 200 pg/l
of green algae — for sample source 2.

The current output of channel 1 will only be refreshed after the measurement of sample source 1. The current
output of channel 2 will only be refreshed after the measurement of sample source 2.

Example for the setting above:

Source Conc. Source 1 Conc. Source 2 Output channel 1 | Output channel 2
measured [ng/1] [Hg/l] [Hg/l] [g/l]
No data filter Source 2 only
2 50 0 4mA 4mA
1 50 0 12mA 4mA
2 50 100 20mA 10mA
1 50 100 12mA 10mA
2 100 20mA 10mA
1 0 100 4mA 10mA

There are also output options for the alarms. If there is no alarm, the output is set to 4mA, otherwise to 20mA.

The Test 4 mA, Test 12 mA and Test 20 mA buttons can be used for test purposes. If one of these buttons is
clicked, the current indicated on the button can be measured at the corresponding output.
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Depending on the output device, the 4 to 20mA output may also be calibrated. If this option is available, just
click on the 4 and 20mA buttons in the calibration section of each output:

Using the arrow buttons it is possible to adjust the corresponding mA value so that the SCADA system shows
the same value. Press OK to confirm the settings.

Relay Output (Option)

The relay outputs can be configured according to individual needs. The menu item is only available if a relay
board is installed.

The relay outputs can be set in the following modes:

Disabled No function

WatchDog The relay changes between on and off one time per minute during the
measurement. No toggling if a hardware alarm occurs.

Conc. alarm of algae class... The relay switches to the ON position if an alarm of the specified algae class
occurs.

Conc. alarm of total chlorophyll The relay switches to the ON position if an alarm of the total chlorophyll
concentration occurs.

Any conc. alarm The relay switches to the ON position if any concentration alarm occurs.

Hardware alarm The relay switches to the ON position if any hardware alarm occurs.
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Data filter Select the sample source, the relay of the given channel shall react on.

The ON/OFF buttons can be used to test the relay and the cable connections.

The number of channels depends on the number of connected output devices.

SQL Script

This function can be used to run an SQL script on the database to reorganise it or to do some special
calculations. The SQL script is provided by bbe Moldaenke as the case arises.

CALIBRATION

Contains the items to calibrate different bbe instruments (expert level only)

Tools | Calibration | Help

Sample termperature

Ed
param Chlorophyll-A

Offsets (ultrafiltrated) —
Offzets (distilled)

Fingerprints
rD"rr Correction factors

Transmission

Sample temperature

Shows the actual internal temperature. The calibration of the internal temperature shall only be done by bbe
service.

Transmission

Performs a calibration at the offset of the transmission measurement. This is the value that is measured if pure
water (100% transmission) or no transmission (0%) is present.

To calibrate 100% transmission, pure water is required.

1. Go to “CALIBRATION -> TRANSMISSION”. The parameter will be imported and the transmission calibration
dialogue will be shown.
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2. Click “START”

Fill a clean cuvette with distilled water, place it in the AlgaeLabAnalyser and confirm with “OK”.

4. Now 10 measurements of the sample will be executed. The number of the current measurement will be
shown in the field “Measurement”

5. The new gradient for each LED will be shown. “APPLY” starts the transfer of the new parameters to the
AlgaelLabAnalyser.

Transmissionkalibrierung
Measurernent ||-| 0 Start

525 570 10 5ap 470 Uy LED Carcel
Old offzet |n,nans? |u,22131 |n,195?5 |n,2?3|35 ||11314|J ||14:an?1

Mew offset ID IEI IEI IEI IEI IEI Apply

Pl Lk

More

“MORE” shows the settings for the digital-analog converter that controls the LED. This information is only
of value for a maintenance technician.

Chlorophyll-A

This menu item enables an offset measurement with the aid of a filtered sample. In comparison to the other
offset measurements, this is characterized by a significantly faster uptake of the offset, since the FO and Fm
measurements are excluded. Please use this offset calibration when the yellow substance measurement is
excluded.

Offsets

The offset is the signal without algae that has to be subtracted during the measurement. Two offsets have to be
calibrated:
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1. The offset in distilled water. This water has to be free of algae and free of yellow substances. This offset is
used when the determination of yellow substances is switched on. The concentration of yellow substances
is determined during the measurement.

2. The offset in ultrafiltrated water. This water has to be free of algae. This offset is used when the
determination of yellow substances is switched off. The concentration of yellow substances is “in” the offset
and so filtrated sample water has to be used for the offset.

Calibration solution for the ,ultra filtrated water offset and the yellow substances

In the lab, the calibration of the yellow substances can be easily done with tap water. In cases of very small
chlorophyll-a concentration, it is recommended to use ultrafiltered sample of the water (from the water to be
examined). For this the following equipment is needed:

Type of filter:Nitrocellulose filter, pore size 0.45 ym, diameter 47mm (for example: Sartorius Stedim)
Vessels: Depending on the sample volume flask with 5 L content

Negative pressure of 800mbar. The volume of the sample is determined by the instrument to be calibrated,
BBE. For an ALA be about 100ml, requires approximately 5L filtrate for an AOA / AlgaeGuard / A-Tox sensor /
AlgaeTorch about 1L and for an immersion probe.

Offsets (ultrafiltrated)

Performs a calibration of the ultrafiltrated sample water offset.

1. Go to “CALIBRATION > OFFSETS (ULTRAFILTRATED)". The calibration parameters will be transferred from
the AlgaeLabAnalyser and displayed.

2. Click on “START” to initiate the calibration

3. Please fill a clean cuvette with distilled water, place it in the AlgaeLabAnalyser and click “OK”.

4. Subsequently 3 x 10 measurements are executed:
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o Offset of the chlorophyll concentration measurement (F-measurement)
o Offset of the so called fo and fm measurement (Genty parameter).

The current measurement is displayed in the “Type” field. The current number in the “Measurement”
field.

The transmission is displayed for control purposes

After the calibration, the new calibration values are displayed. Please confirm with “Apply” to transfer
the new calibration.

Offsetkalibrierung (Ultrafiltriertes Wasser) il

Tup: IFM-DHset Measurement |3 Shop |
Abbrech
525 570 E10 590 470 UVLED Trans. ﬂl

Old oifset |2,35539 |1,132|Ja |n,4?2au |n,45953 |5,as1?e |5,2148? Digits

Mew offzst |n,n3124 ||1055?3 ||11122? |-u,neea4 |u,nusaa |-u,155|39 Digits % | Anwenden |

et |

“MORE” shows the settings for the digital-analog converter that controls the LED. This information is only of
value for a maintenance technician.

Offsets (distilled)

Performs a calibration of the distilled water offset.

1. Go to “CALIBRATION > OFFSETS (DISTILLED)". The calibration parameters will be transferred from the
AlgaelLabAnalyser and displayed.

2. Click on “START” to initiate the calibration

3. Please fill a clean cuvette with distilled water, place it in the AlgaeLabAnalyser and click “OK”.

4. Subsequently 3 x 10 measurements are excecuted.:
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o Offset of the chlorophyll concentration measurement (F-measurement)
o Offset of the so called fo and fm measurement (Genty parameter).

The current measurement is displayed in the “Type” field. The current number in the “Measurement”
field.

The transmission is displayed for control purposes

After the calibration, the new calibration values are displayed. Please confirm with “Apply” to transfer
the new calibration.

Offsetkalibrierung (Destilliertes Wasser) il

Tup: IF-foset Measurement I'IU Stkart |
Abbrech
525 570 E10 590 470 UVLED Trans. ﬂl

Old oifset |2,2D?43 |1,49253 |1,aas?1 |D,84044 |1,F"E|128 |D,22315 Digits

Wew offset |n,n1?45 |n,na1sn |n,05535 |n,02322 |EI,IZII335? |-u,09353 Digits [95.3F7 % | Arwenden |

Mehr |

“MORE” shows the settings for the digital-analog converter that controls the LED. This information is only of
value for a maintenance technician.

Fingerprints

This menu item subsumes the fingerprints of algae classes and yellow substances. The fingerprints contain the
fluorescence characteristics of the algae classes or yellow substances. The fingerprint of the algae classes
shows the signal of the pure solution based on a concentration of 1ug/l. For the fingerprints of yellow
substances the concentration is chosen arbitrary. Their classification serves mainly the correction of the
fluorescence signal during the classification of algae.

The names of the algae and if a fingerprint is an algae or a yellow substance can be defined in the parameters.

For the calibration of the algae fingerprints, please use pure solutions of the algae division with a known
chlorophyll concentration. The concentration should be in the range of 20-80 ug/I.

1. Go to “CALIBRATION > FINGERPRINTS”. Now the parameters are imported from the device and the
calibration dialogue is shown.

2. Select the algae class to calibrate
Insert the concentration. Concentration values should be in a range of 20 — 80 pg/I.

If the concentration is determined later insert “1” and use the “calibration by factor” feature to adapt the
calibration after specifying the concentration.
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5. Please choose from the “Type of offset’-field if the sample was diluted with filtrated or distilled water.
6. Click on “START”

7. Please fill the calibration sample in a clean cuvette, place it in the AlgaeLabAnalyser and click “OK”.
8. After the calibration the new fingerprint is shown.
9. Apply the values by clicking “Apply”.

10. Repeat the procedure with all algae classes activated in the AlgaeLabAnalyser

Correction factors

Go to “Calibration - Correction factors”. Now the parameters are imported from the device and the fingerprint
correction dialogue is shown.

Correction of a fingerprint

This item allows the correction of a specific fingerprint using a particular factor. If one algae class is under- or
overestimated compared to your reference, the fingerprint can be changed automatically. Entering for example
the factor 2 will double the result for the chosen algae class. After entering the number, the new fingerprint is
displayed. Use the “APPLY” button to send it to the sensor.

FACTORY DEFAULT: This option can be used to reset a specific fingerprint to the factory settings. This feature is
only available in sensors with an internal software 1.96 or later. Otherwise, this option is greyed out.

Calibration of Fingerprints with Subsequent Wet-Chemical Analysis:

If the AlgaeLabAnalyser is calibrated with a reference solution where the concentration is determined
subsequently, the following steps have to be carried out:
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¢ Do afingerprint calibration as described above, but enter 1 for the concentration of the reference solution
¢ Do a wet-chemical analysis

e Use the “Calibration by factor” feature to adapt the calibration to the result of the subsequent wet-chemical
analysis.

Example:

The result of the subsequent chlorophyll analysis is 35ug/l. In this case the factor is 35.

Attention: the AlgaeLabAnalyser is not ready for use until the last step has been carried out.

HELP
Help |
About bbe++ ...
bbe++ Handbuch AlgaeslabAnalyser.pdf
bbe+= Handbuch AlgaeOnlineAnalyser.pdf
bbe+= Manual AlgaelabAnalyser.pdf
bbe+= Manual AlgaeOnlineAnalyser.pdf
bbe+= Manual BenthoTorch. pdf
: bbe+= Manual FluoroProbe,pdf
About ...

Displays the start-up screen.

For further questions, please contact our service. Please let us know the Software version you are using and the
serial number of your instrument.

New version can be downloaded from http://www.bbe-moldaenke.de/.

bbe++ manuals ...

List of currently installed bbe++ manuals. Depending on the selection made during the installation, there may be
manuals in different languages and for different instruments.

To make further manual available, please store the PDF files in the following folder:
Windows XP: C:\Programme\bbe++\
Windows Vista or Windows 7: C:\Programme (x86)\bbe++\)
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THE VIEWS

TABLE VIEWS

A table view is opened by “WINDOW - NEW TABLE VIEW - TABLE VIEW NAME®.

g bbe + +.bdb [FP-18-03] :1

=10] x|

15.06.2009 09:10:50

15.06,2009 09;10:532 1]
15.06,2009 09;10:35 1]
15.06.2009 09:10:57 il
15.06,2009 09;11:00 1,08
15.06.2009 09;11:02 1]
15.06.2009 09;11:04 0,0475
15.06.2009 09:11:07 u]
15.06,2009 09,1100 1]
15.06,2009 09;11:12 1]
15.06.2009 09:11:14 il
15.06,2009 02;11:16 1]
15.06.2009 09;11:19 0,945
15.06.2009 09;11:21 1]
15.06.2009 09:11:23 3,35
15.06.2009 09;11:26 N 1,07
15.06,2009 09;11:28 1]
15.06.2009 09:11:31 1,52
15.06,2009 09;11:332 1]
15.06,2009 09;11:35 1]
15.06.2009 09;11:38 5,41
15.06.2009 09:11:40 3,26
15.06.2009 09;11:42 0,792
15.06,2009 09,1145 2,92
15.06.2009 09:11:47 6,68
15.06,2009 09,1150 5,56
15.06,2009 09;11:52 1]
15.06,2009 09;11:54 1]

< |

0,813 i 0,495
1,04 il il
il il il
2,28 i i
0,829 il il
0,142 il 2,09
0,956 il 0,908
0,932 i i
1,2 il il
0,74 il il
0,561 i 0,936
0,698 il il
0,779 il il
0,804 il il
i i i
0,488 il il
0,261 il 2,03
0,227 i i
1,1 il il
1,58 il 1,597
il il 0,883

i 2,18 i

il 2,82 il

il 1,33 2,85

i i 1,54

il 0,939 0,492
0,111 1,16 il
0,363 il 0,598

Date/Time [date] I Conc O [Green Algae] [pgfl]l Conc 1 [Bluegreen] [pgfl]l Conc 2 [Diatoms] [pg/l] | Conc 3 [Cryptophyta] [ugfl]l Conc <~
o

M o4

Within the list view, the right mouse button offers detailed information about the selected data set.

Date/Time [date]

| Cnmmentl Comment [1

History of Parameters
Edit Comment
Delete Data
Data Fields Selection
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History of Parameters

HISTORY OF PARAMETERS shows the corresponding parameters for the given instrument and time. For details,
see the description of the data menu.

x
Common parameters  Fit parameters |
Device: IFF'-EI?-EI‘I Creation date of pararmeter set: I3IJ_US_2UUB 090737 j Original
Hame | Yalue | Lt |
& Enabled for fit flag Cloroficeas on
& Enabled for fit flag Cianoficeas oh
& Enabled for fit flag Diatomeas/Dinafl on
& Enabled for fit flag Cryptoficeas on
& Enabled for fit flag Ozcilatoria off
& Enabled for fit flag #5 off
& Enabled for fit flag #7 off
& Enabled for fit flag Sust. amarilas oh

E=port | 0K I Abbrechen [l ermehmer

Edit comment

EDIT COMMENTS allows the user to change the comments of a specific data set retrospectively.

x

Title | Type | Text |
Comment | Test First comment

Operator | Test
pH Murnber ~ |iE
Carce_|

The dropdown list contains previously entered comments (if applicable).
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Delete data

To delete data rows from the data base, mark one or more row by clicking on the row.

Hold the Ctrl. key while clicking to add more rows to the selection.

14.10.201516:53:58

1410201517
14.10.201517:12:58
14.10.201517:53:58
14.10.2015 18:03:
1410201518
14.10.2015 18:53:58
14.10.201519:03:58
14102015 19:53:58
14102015 20:03:58
14.10.2015 20:12:58
14.10.2015 20:53:58
14.10.2015 21:03:58
14102015 21:12:58
14102015 21:53:58
14.10.2015 22:03:58

Hold the Shift. key while clicking to expand the.

14,1040 1030
14.10.2015 16:12:58
14.10.2015 16:
14.10.2015 17
14.10.201517
14.10.2015 17
14.10.2015 18
14.10.2015 18
14.10.2015 18

14.10.2015 2
1410.2015 11
14.10.2015 22:
14.10.2015 22:12:
14.10.20

14.10.2015 23:03:
14.10.2015 23:12:58
14.10.2015 23:53:58

Select “Delete Data”

History of Parameters
Edit Comment

Delete Data

Data Fields Selection

14.10.2015 20:0
14102015 20:
14102015 20
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All data or the selected only can be deleted. Click OK to delete.

Data Fields Selection

To add or remove columns from the list view use “Data fields selection”. The dialog is similar to the dialog of the
View Editor.

Field Selection x|

Table iz sorted accaording to first entry

— Fieldz
Available Selected

Tranz. 700 nm [digits]

a Date/Time [date]
LED 2 [325 nm] [digits] Add -» | Green Algae [pa]
LED 3 [570 ni] [digits]

Bluegreen [pag/l]

LED 4 [610 nm] [digits] ‘R Diatoms [pa/l]

LED 5 [370 rm] [digits] —l< ST 1 | Cooptophyta [ug/l

LED E [530 nrn] [digits] Yellow substances [pagsl]
LED 7 [470 nm] [digits] Up | Total cone. [pasl]

Pressure [bar] Tranzmizsion [%]

Temp. LED: ["C] Down | Diepth [m]
Temp. Senzor [C]

Temp. Sample ['C]

Ok |

Please select or deselect the columns. The list view is updated immediately.

Sorting of the list view

The list view is sorted by date/time. It can be sorted by any other column by clicking on the header of the
column. Clicking twice leads to the reversed order.

Sorted by time/date ascending:

Date| Time [date] | Green Algae [Lgfl |

26.06.2007 10:04:14 0,00
£6.06.2007 10:04:29 0,00
£6.06.2007 10:04:45 0,00
26.06.2007 10:05:00 0,00
26.06.2007 10:05: 16 0,00
£6.06.2007 10:05:32 9,43
26.06.2007 10:05:47 0,00
26.06.2007 10:06:03 0,00
26.06.2007 10:06:19 0,00
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Sorted by time/date descending:

Drate Time [date] | areen Algae [ugfl]
26.06.2007 12:19:30 0,00
26.06.2007 12:19:14 0,00
26,06,2007 12:15:59 0,00
26.06,2007 12:158:44 0,00
26.06.2007 12:15:29 0,00
26.06,2007 12:158:13 0,00
26,06,2007 12:17:58 0,00
26.06,2007 12:17:43 0,00
26.06.2007 12:17:28 0,00

Sorted by green algae descending:

Date) Time [dake]

| Green Aloas [ug_ﬂu

£6.06,2007 10:05:32
26.06,2007 100942
26.06.2007 11:20:26
£6.06.2007 11:23:16

£6.06.2007 10:16:14

26.06,2007 11:
26.06.2007 11:

05:26
525:09

26.06.2007 10:17:43

£6.06.2007 11:

3ms3

XY GRAPH VIEWS

9,46
2,97
2,89
1,93
1,31
1,24
0,32
0,13
0,12

Features of the XY graph view:

1.

Select data of interest

Editing a XY view, to change colours the type of graph.

2. Scaling of the axes (right click)
3. Display of the corresponding parameters (right click)
4.
5

. Navigation within the data
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Select data of interest

Please click and draw the mouse to select the required data.

Bbbe ++.bdb [FP-18-03] :2

Time vs. Concentration
Jl Conc 0 [Green Algae] [l Conc 1 [Bluegreen] [l Conc 2 [Diatoms] | Conc 3 [Cryptophyta] [| Conc 4 ji#4] || Conc 5 [#5] | Conc 6 [#6]  Conc 7 [Yellow substances] ] Conc Total

X

Time vs. Concentration

[l Conc 0 [Green Algae] [l Conc 1 [Bluegreen] [l Conc 2 [Diatoms] [| Conc 3 [Cryptophyta] [| Conc 4 [#4] [| Conc 5 [#5] || Conc 6 [#6]  Conc 7 [Yellow substances] ] Conc Total

X only
Y oy
X and Y
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X only only the selection on the horizontal axis is applied.
Y only only the selection on the vertical axis is applied.
XandY the selection on the horizontal and the vertical axis is applied.

B bbe+ +.bdb [FP-18-03] :2

Time vs. Concentration
Jl Conc 0 [Green Algae] ] Conc 1 [Bluegreen] | Conc 2 [Diatoms] [I Conc 3 [Cryptophyta] || Conc 4 [#4] || Conc 5 [#5] || Conc 6 [#6]  Conc 7 [Yellow substances] ] Conc Total

X only applied

Bbbe+ +.bdb [FP-18-03] :2

Time vs. Concentration
I Conc 0 [Green Algae] I Conc 1 [Bluegreen] [| Conc 2 [Diatoms] || Conc 3 [Cryptophyta] || Conc 4 [#4] | Conc 5 [#5] | Conc 6 [#6] Conc 7 [Yellow substances] I Conc Total

Y only appliedMinimal
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B bbe + +.bdb [FP-18-03] :2

Time vs. Concentration
ICnnc 0 [Green Algae] I Conc 1 [Bluegreen] [| Conc 2 [Diatoms] || Conc 3 [Cryptophyta] || Conc 4 [#4] | Conc 5 [#5]

Conc 6 [#86]

Conc 7 [Yellow substances] I Conc Total

X and Y applied

Right-click menu

Scale axes

v Atoscals
FParameter
Default scaling

Features:

>

>
>
>

adjust the scaling .
activate and deactivate of the autoscaling feature.
show the parameters of a single data-set.

return to the default scaling.

Scaling of the axis

By default, scaling is done automatically. This means, all datasets of the selected period are displayed. To have
a closer look at the data, it is sometimes useful to change the scaling. In the right-click menu, there is a “Scale
axis” option:

In case of a time axis, the scaling tab of this axis is as follows:
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Axis scaling X|

Hebuiis | Frimnary Y-.-’-‘w:isl

Date Time

Fist  |El042009 | |10:2437

Lt |m.n4_2uus j |15:2?:25

EEL EE

(] 4 I Abblechenl Ulgemehmenl

The first and last point in time have to be entered.

‘ Hint: For more information on scaling an axis please see the "window" section in this manual.

In case of a “non-time axis”, more possible adjustments are available:

Axis scaling x|

Sotuge  Primang vtz |

r— Manual Scaling

Min |E—

[LEH IIJ

Aot Scale Limits
r— Lowser lirnit

™ Higher than ID—

[ Lower than

— Lpper limit

™ Higher than ID—

[ Lower than

0K I Abbrechen [Eermehmen

Manual scaling:

Auto scale limits

enter fixed values for the minimum and the maximum of this axis - enter 0 for both to
disable this feature.

these settings are used to obtain a nice looking graph in two special situations:

e data sets with very low noise:

In the auto-scaling mode, the graph looks as if there are extreme variations, but the range
is very small due to the auto-scaling. In this case, it is better to use the options:

lower limit: lower than and
upper limit: higher than

This leads to a minimum span in the graph.

. data sets with outliners:

In this case, it is difficult to analyse the data because the auto scaling generates a high
span value. To prevent this, please use the

lower limit: higher than for outliners with low values and
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upper limit: lower than for outliners with high values

This leads to an optimised span in the graph.

Autoscaling

Enables the auto-scaling feature. The axis will be scaled so that all selected data are visible.

Parameters

Show the parameters of the data-set

Default scaling

Click here to undo all the changes in the scaling options.
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PARAMETERS

The following pages show the parameters that are visible in the service access level. In the user level not all of
these parameters are visible.

PROCESS PARAMETERS

These parameters are used to control measuring process

LED measuring time

Controls the LED measuring time in older ALA instruments.

Measurement interval

Interval between the start of one measurement and the start of the next measurement. This is only active in the
continuous mode. If the measurement process is longer than the interval, a continuous measurement is
performed.

Number of chlorophyll (f) measurements

Number of measurements that are executed and averaged for one data set.

Measurement duration (f, fm, fo, transmission)

Please enlarge the measurement duration to enhance the accuracy of the measurements.

Minimum chlorophyll (f) concentration

Below this concentration no algae activity is calculated.
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Enter comment at start of measurement

If enabled, a comment related to the measurement can be entered. Please see window -> comment field for

detailed configuration.

Activity

Enables / disables the activity measurement (if available in the instrument)

Continuous measurements

If enabled a continuous measurement is performed.

Number of available sample channels

Shows the number of available sample channels — can only be changed by the bbe service

Pump mode

Please select the way the sample pump is working.
ON: Always working

OFF: Off

Interval: Pump is working at the beginning of each measurement

Pump time start up

Time, the pump is running before the first measurement. This is to get fresh sample and to remove remaining

water from the measuring cell.
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Adaptation time (f, fo )

Period of time before the measurement starts. During this time, the LEDs are switched on to adapt the algae to
the light conditions.

Integration time fm measurement

Averaging time to smooth the fm results.

ALARM PARAMETERS

These parameters control the alarm generation. Alarms are generated as soon as a threshold is exceeded. For
each algae class and the total chlorophyll concentration a threshold can be set. In combination with a relais
output, the alarms can be used to trigger an external device (like a sampler).
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Alarm limit

Set the threshold for the algae class

Enable alarm

Enables the alarm.

COMMON PARAMETERS
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Warm-up time

Period of time, before the measurement starts.

Serial number

Serial number of the ALA.

Software version

Shows the version of the firmware.

FIT PARAMETERS

These parameters control the calculation of the results from the raw data.

Name of class

Enter the name of the calibrated algae class or the name of the yellow substance.

Enabled for fit

The enabled for fit section allows selecting maximum 5 of 8 calibrated algae classes for the calculation of the
concentration of the different classes. Please take care, that all algae classes available in the water are
activated.
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Yellow Substances Correction

Please select, whether this is a Yellow Substances fingerprint or not. Yellow substances content is not included
in the total chlorophyll concentration.

Offsets

The results of the offset calibrations are shown here.
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Transmission offsets / gradients

Shows the result of the transmission offset calibration.

Fingerprints

Displays the results of the algae class calibrations.
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Standard deviations

Standard deviations of the fingerprints of each algae class. This standard deviation refers to variations within
one specific algae class. The greater the standard deviation, the less important the measured value for this
algae class

Date of calibration

Shows the date of the last factory calibration.

Global correction factor

Factor to adapt all measured chlorophyll results. All results will be multiplied with this factor.

Cell factors

Factors to convert the chlorophyll concentration [ug/l] results to cell counts [cell/l]. These factors can be defined
separately for each algae class.

Fo measurement brightness

Brightness of the LED light during the fo measurement in relation to the brightness during the standard
chlorophyll measurement.

Manual for the bbe AlgaeOnlineAnalyser Page 112



Parameters

MEASUREMENT PARAMETERS

DA values of the LEDs

Values result of the brightness regulation (service, do not change)

Temperature and Humidity offsets / gradients

Shows the result of the Temperature and humidity sensor calibration.

Required values of the LEDs

Values for the basic calibration of the ALA
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Temperature correction

Temperature correction factors for the given temperature ranges.
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OPERATING PRINCIPLES

PRINCIPLES OF OPERATION

Due to the fact that algae of the same division contain a similar quantity and quality of photosynthetic pigments,
their fluorescence excitation spectrum (with a fixed emission wavelength at 680nm) is significant. Thus, it is
possible to differentiate divisions of algae by their fluorescence excitation spectrum. In addition to this, other
fluorescing matter (for example, yellow substances) is detected to enhance the accuracy.

The bbe fluorometers use 6 LEDs for fluorescence excitation for algae differentiation. The LEDs emit light at 6
selected wavelengths (370nm, 470nm, 525nm, 570nm, 590nm and 610nm).

DETERMINATION OF DIFFERENT ALGAE

The division of chlorophyceae (green algae) shows a broad maximum of fluorescence at the 470nm LED, which
is caused by chlorophyll-a and -b. The cyanophyceae (blue-green algae) have their maximum at 610nm due to
the photosynthetic antenna pigment phycocyanin. Cyanophyceae also contain chlorophyll-a if there is low
intensity at 470nm. This is due to the masking effect of the phycocyanin. Furthermore, the high peak at the
525nm region for the bacillariophyceae originates from xanthophyll fucoxanthin and for the dinophyceae from
peridin. The maxima at 470nm are caused by chlorophyll-a and -c. In our last analysed group, cryptophyceae, a
significant maximum can be found at 570nm, which originates from phycoerythrin.

The different divisions of algae are first measured separately to calibrate the instrument. The measured spectra,
or fingerprints, are then stored in the FluoroProbe.

During the measurement, the spectrum of the sample is loaded into the storage device of the instrument or sent
to an external computer. The computer calculates the content of the different divisions of algae in the sample
from the sample spectrum and the spectra of the separately measured algae divisions.

The concentration of every algae division is given in ug chlorophyll-a/l.

DETERMINATION OF YELLOW SUBSTANCES

Yellow substances may fluoresce.

The UV LED (370nm) is used to measure yellow substances in the water. At 370nm it is possible to differentiate
between algae (low signal) and yellow substances (high signal). The result of this measurement is given in
relative units and not in weight/volume, because very different substances are detected. The result is mainly
used to obtain a more accurate determination of algae classes — but it is also possible to determine the
variations of the yellow substances.

DATA ANALYSIS

Offset

The LEDs in the bbe fluorometer are switched on one after the other at high frequency. The fluorescence signal
for each LED is taken and averaged during a given measuring time. The fluorescence values for each of the
LEDs are given at the end. The concentration of the algae has to be calculated from these values.

The first step is to subtract the signal that does not come from the algae. This type of signal is also called offset.
There are two types of offsets:
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1. the signal from the bbe fluorometer itself, from the electronics and the optical system
2. the signal from fluorescent substances in the water that are not algae.

The first signal is determined by a measurement with distilled water — water without any fluorescent substance.
The second signal can be determined by a measurement in ultra-filirated sample water. This water only
contains fluorescent substances that are not algae. Ultra-filtration is here understood as filtration with a ‘mesh
size’ of 0.2 ym.

In the case of a varying concentration of these substances in the water, the subtraction fails. This is why the
determination of yellow substances has been integrated into the bbe fluorometer. Yellow substances are treated
as one algae class. Varying concentrations can be detected — assuming the fingerprint of the calibrated yellow
substances matches the yellow substances in the sample.

The first signal only depends on the instrument and only varies within a relatively small range. So there is no
need to calibrate these settings. The second signal depends on the sample, so there may be a need to calibrate
this.

Algae classes

After subtracting the offset from the measured fluorescence signals, the remaining signals have to be assigned
to the different algae classes. A statistical calculation procedure in the software finds the best combination of
concentrations of algae classes for the measured pattern of signals.

The total chlorophyll concentration is the sum of all detected concentrations of algae classes.

The signal can only be assigned to algae classes that are calibrated and activated in the instrument. Algae
classes in the sample that are not part of the calibration will lead to miscalculations.

The different algae classes used for the statistical fit need to have significantly different fluorescence spectra
such as the spectra calibrated by bbe in the bbe fluorometer. In case of queries, please ask bbe Service.

MEASUREMENT OF THE ALGAE ACTIVITY

The fluorescence response to a very bright light impulse is measured under two different conditions. There is
one measurement with and one without a very bright additional background light.

For the algae the light is the energy source and therefore like food. Without the additional background light, a
large amount of the light impulse is used as "food". So hardly any light is emitted in the form of fluorescence. If
there is enough light because of the background light, the level of the fluorescence response will increase
considerably. If the cell is damaged, the cell will not use the light and even without additional background light
there is a greater fluorescence response to the light impulse.

The so-called Genty parameter sums up the process and provides a measure of algae activity:

fm— fo
——

Genty=100* %]
fm

This is:
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Genty: shows the activity of the algae in percent whereby up to 75% is reached depending on the algae class
and the physiological condition.

fo: fluorescence response without background light

fm: fluorescence response with background light

MEASUREMENT OF FURTHER VALUES AND THEIR CALCULATION

IN GENERAL

Generally, all measuring results are read into the PC as a figure between 0 and 4095. These have to be
converted into the corresponding measuring values — for example, the transmission. As a unit of measurement
for the figures, "digits" is used in the following.

The conversion of the figures into measuring values will generally be calculated by use of the following
equation:

Measurement Value = Gradient * (Figure — Offset)

The "offset” is the number which is read in if the measuring value is 0. "Gradient" is the conversion factor from
the figures that are read into the measurement value.

Example:

0 digits is the same as —20°C

1200 digits is the same as 100°C

So the offset is 200 [digits] and the gradient 0.1 [°C/digit].

TRANSMISSION

The transmission of the sample is measured at 5 different wavelengths: 470 nm; 525 nm; 570 nm; 590 nm;
610 nm.

The sensor is calibrated in a way that clear water has a transmission of 100% and “perfectly black water” has
one of 0 %. The transmission can — in a limited way — also be used to compensate the fluorescence signal in
cloudy water.

Calculation of the transmission from the sensor signals

Transmission [%] = Gradient [%/digit]* (Signal [digit] — Offset)

Compensation of the chlorophyll concentration by the transmission

The compensation is based on measurements using clay as a model for turbidity. The coefficients are the same
for all ALAs.

Two effects are compensated:

1. The higher offset due to additional reflection on the particles
2. The change of the signal (raw value) due to the mitigation of the light.

The correction is done separately for each LED.
Offset compensation:
Offset corr. (A\) = Offset(A) + a * (100-Transmission (A))? + b * (100-Transmission (A)) * Average Fingerprint (LED)

a, b are parameters, determined by bbe.
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Second step is the complete compensation of the raw value:

Raw corr. (A). = Raw (A). * (1 + Factormsgation(A) * (100-Transmission))

After doing the correction, the calculation of the chlorophyll concentrations is done as normal.

TEMPERATURE OF THE SENSOR

The very small temperature drift of the sensor can be compensated additionally. Compensation factors for pre-
set temperature ranges can be set.

Calculation of the temperature compensation

Chlorophyll concentration [ug/l] = measured chlorophyll concentration.[ug/I] * correction factor (Temp)

If the measured chlorophyll concentration at an internal temperature of 20°C is 100ug/l and at an internal
temperature of 30°C is 101ug/l, the correction factor is 0.99 at 30°C.

BRIGHTNESS OF THE LED

The fluorescence signal depends directly on the brightness of the excitation lamp of the diodes. The brightness
is regulated to the target value at the beginning of each measurement. Afterwards the brightness and the
correction values are determined regularly.

MEASURING PROCEDURE

The bbe Algae Online Analyser was calibrated before delivery with bbe standard algae types and yellow
substances. In case of the presence of algae types that are not calibrated or in case of different types of yellow
substances, the bbe Algae Online Analyser needs to be calibrated to these special needs first. This is most
important if there are only low concentrations of algae (< 10ug/l).

INITIAL MEASURING PROCEDURE

o Start the instrument and in case of an external PC also the PC and the AOA Software
e Connect the sample tubes to the sample supply and test it by choosing Test - Pump
o Start the measurement (Measurement — Start ).

¢ A window appears where the COM port has to be chosen.

o At the end of the measurement, stop the measurement. The data are saved automatically in the database .

OFFSETS

The following possibilities are available to deal with the offset:

1. The offsets are most important if the concentration of chlorophyll is low, for example lower than 10ug/l.
In such cases, the fingerprint of the yellow substances should be recalibrated by using ultra-filtrated
sample water (see below).

2. In case of stable yellow substance concentrations, the results may become more stable if the yellow
substances are deactivated. In this case, the offset “ultra-filtrated water” is used for the calculation.
Please calibrate this offset before choosing this option.

MEASURING PROCEDURE FOR LOW CHLOROPHYLL CONCENTRATION

The lower the chlorophyll concentration, the more exact the offsets and the yellow substance offset have to be.
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BACKGROUND FLUORESCENCE

The first consideration is whether the background fluorescence (fluorescence of the ultra-filtrated sample) varies
its concentration or not.

e In case of a stable background fluorescence, the best choice is to deactivate the yellow substances in the
“Parameter of fit” window and perform an offset calibration with ultra-filtrated sample water.

e In case of varying background fluorescence, the best choice is to measure this fluorescence as yellow
substances. Please perform a fingerprint calibration of the yellow substances with ultra-filtrated sample
water. The yellow substances need to stay activated.

CLEANING

Please ensure that all tubes and the measuring chamber are really clean. Especially after measuring high
concentrations of chlorophyll, multiple rinsing is recommended. To check the cleaning status of the whole
system, please perform a measurement with distilled water. The result should be 0. If not, take also in
consideration that the tubing might be dirty inside.

Please note: Deionized water may also contain fluorescing substances.

MEASURING TIME

For low concentrations of chlorophyll, please prolong the measuring time to 60s for lower noise.

SEDIMENTATION

In case of sedimentation of algae in the sensor, choose the operation mode “Always on” for the internal pump.

SAMPLE PREPARATION

To dilute a sample, please use algae nutrient solution. Tap water may lead to a different status of the algae. The
prepared sample is also more stable in a nutrient solution.

Please note: algae may change their fluorescence properties in relatively short time periods.

In case of deactivated yellow substance fingerprints, the dilution has to be carried out with ultra-filtrated sample
water.

CALIBRATION PROCEDURE

GENERAL CONSIDERATIONS:

e To add any type of solution to the chlorophyll sensor, please use the syringe supplied as an accessory.
Disconnect the internal pump and connect the syringe at the sample outlet. To apply a solution, suck it up
into the chlorophyll sensor by using the syringe.

o Make sure that the chlorophyll sensor is really clean! Do a cleaning procedure first.

CALIBRATION OF THE OFFSETS:

o For the calibration of the offsets, please use ultra-filtrated sample water and distilled water.
o Apply distilled water. Start using Calibration -> Offsets (distilled).

o Apply the values after the calibration.

¢ Apply ultra-filtrated sample water and start using Calibration -> Offsets (ultra-filtrated) .

o Apply the values after the calibration.

CALIBRATION OF THE ALGAE FINGERPRINTS:

e Do an offset calibration first.
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e For the calibration of the algae fingerprints please use pure solutions of the algae division with a known
chlorophyll concentration. The concentration should be in the range of 50-100ug/I.

o Apply the algae solution.

e Choose -> Calibration -> Fingerprints in the software, choose the algae class and enter the concentration.
e Choose the type of dilution water used for the calibration.

e Start the calibration.

e Apply the values after the calibration.

CALIBRATION OF THE YELLOW SUBSTANCES:

¢ Do an offset calibration first.
e For the calibration of the yellow substances please use ultra-filtrated sample water.
e Apply the solution.

e Choose Calibration -> Fingerprints in the software, choose the yellow substances and enter 1 r.u. as the
concentration and start the calibration.

e Apply the values after the calibration.

CALIBRATION BY FACTORS:

The assumption for this type of calibration is that there is a number of results of the Algae Online Analyser and
of a reference method that show a certain factor for one algae class. It is highly recommended to use only
measurements where this algae class is dominant and the concentration at least 10ug/I.

e Choose -> Calibration -> Correction factor in the software
e Choose the algae class and enter the determined factor.

e Apply the values.

CALIBRATION OF FINGERPRINTS WITH SUBSEQUENT WET-CHEMICAL ANALYSIS:

If the Algae Online Analyser is calibrated with a reference solution where the concentration is determined
subsequently, the following steps have to be carried out:

¢ Do afingerprint calibration as described above, but enter 1 for the concentration of the reference solution
¢ Do a wet-chemical analysis

o Use the “Calibration by factor” feature to adapt the calibration to the result of the subsequent wet-chemical
analysis.

Attention: the Algae Online Analyser is not ready for use until the last step has not been carried out.

BATCH MODE OPERATION

The batch mode can be used to operate the instrument with single samples for example in the lab. While in the
online mode everything is automatically done by the software, in the batch mode every step can be influenced
by the user.

To switch in the batch mode, activate “batch” in the view menu. The batch panel to operate the instrument is
displayed. Depending on the features of the chlorophyll sensor the Activity and Transmission click boxes are
greyed or not greyed.

The sample can be taken from a canister or similar container. To get the sample into the sensor, either the
internal pump or a syringe can be used.
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+ Transm. .
Cleaning Pump
v Cleaning

Single channel version

Multi-channel version

To perform a measurement, please carry out the following steps:

1.
2.

Mount the tubes on the instrument so that the container and effluent can easily be reached.

Put the suction tube in the container and click “Pump”. The pump runs as long as the value given in “Fill
sensor” in the Parameters. Hint: The pump should work as long as it takes to pump sample out of the
effluent of the sensor.

In case of a multi-channel instrument 2 or more pump buttons are available. Please use the button of
the appropriated sample.

Press “Start” to start the measurement. If Transmission measurement and/or cleaning shall be executed
at the end of the measurement procedure, click the according checkboxes The measurement times etc.
are given in the Parameters menu.

Put the suction tube in clean water and press pump to rinse the sensor. If there are variations in the
different samples, this has to be carried out very carefully, i.e. 3-4 times.

It also helps to use the clean option while pure water is in the chamber. This requires one more rinsing
afterwards. If there is enough sample water, it is recommended to use the next sample for rinsing.
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DATA EVALUATION

To evaluate the data, either the PC of the instrument itself can be used or any other PC on which the AOA
software is installed.

On a desktop PC, please install the bbe++. Now any bbe++ database file (*.BDB) can be opened for evaluation.
The file can either be on the PC or in the LAN network.
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SERIAL DATA EXCHANGE

To change settings for the serial data exchange go to Tools -> settings -> Text results.

The protocol is ASCll-based. The Algae Online Analyser waits for a character and then sends an answer if a
command has been recognised. The following commands are allowed:

o “h” request for the header with the names of the single data.

e “u”request for the units of the single data.
e “d”request for the actual dataset.

e “s”to start the measurement. In this case there will be no answer string.

o “p”to stop the measurement. In this case there will be no answer string.
The answer is a string terminated with CR and LF. Each string contains aa fixed number of separated fields.
The data fields and setting are defined in the output view chosen in Tools -> setting -> text results.

The commands ,h* and ,u“ always return header and units. Please note the unit string contains the character “y
ASCII code 230. This might appear as ,a&“ when ANSI coding is applied.

The “d” command always returns the actual dataset. If there is no new dataset since the last request, the same
dataset is delivered.

The first 5 data fields are fixed and always transmitted:

Feld | Typ |Inhalt

1| Text | Checksum in the format "Pxx", where xx is a hexadecimal value in text
representation for example "POF" - P: marker for checksum; OF: hexadecimal
representation of 15.

Text | Number of software version

Zahl | Number of data fields

Text | Day, month, year in the format "DD.MM.YYYY"

g A WO N

Text | Date and time in the format "hh:mm:ss"

The first field is the checksum of the whole string. The format of the checksum is a P (capital) and a two-digit
hexadecimal number. The checksum is an XOR function of the following characters, excluding the TAB directly
after the checksum and excluding the CR and LF. All the other TABs are included. The calculation of the
checksum starts with 0. The 0 is linked by XOR to the ASCIlI number of the first character after the first TAB.
The result is linked to the ASCII number of the second character, and so on.

“C” example for the calculation of the checksum:

char * response; /* response enthdalt den vollstdndigen Antwortstring */
int 1 = 4; /* Prifsumme und erstes TAB nicht beritcksichtigen */

unsigned char checksum = 0; /* Startwert ist 0 */

while (response[i] && (response[i] != '\r') && (response[i] != "\n'))

{

A

checksum = checksum response[il];
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The value in the checksum has to be the same as the two-digit number after the P.

Examples: The data fields might vary according to the settings:

External device send the request “h”. Answer:

P1B 02.00 33 Datum Uhrzeit Konz. 1 Konz. 2 Konz. 3 Konz. 4
Konz. 5 Konz. 6 Konz. 7 Konz. 8 Gesamtkonz. Transmission
Tiefe Temp. Probe Zellz. 1 Zellz. 2 Zellz. 3 Zellz. 4
Zellz. 5 Zzellz. 6 Zzellz. 7 Zzellz. 8 Gesamtzellzahl Trans. 700
nm LED 3 LED 4 LED 5 LED 6 LED 7 LED 8 Druck Temp. LEDs Temp. Sensor

Externer Rechner sendet ,u“, Antwort:

P4D 02.00 33 Datum Uhrzeit pg/l wg/l pg/l ng/l pg/l
ng/l % m °c Zellen/ml Zellen/ml Zellen/ml
Zellen/ml Zellen/ml Zellen/ml Zellen/ml Zellen/ml
Digits Digits Digits Digits Digits
°C °C

Externer Rechner sendet ,d“, Antwort:

P33 02.00 33 25.11.2014 14:27:38 0,00 1,66 0,00 0,00
0,00 1,66 100,00 -0,10 15,10 0O 1656 O 0
0 1656 354,22 4,29 4,01 12,29 2,37 7,68 2,59

ng/l ng/l ng/l

Zellen/ml
Digits
Digits bar

0,00 0,00 0,00

0,99 16,95 15,146
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TECHNICAL DATA

Description Value
total chlorophyll [ug Chl-a/l]
concentration of green algae [ug Chl-a/l]
concentration of cyanobacteria [ug Chl-a/l]
concentration of diatoms [ug Chl-a/l]

Measurands concentration of cryptophytes [ug Chl-a/l]
yellow substances
photosynthetic activity (Genty) — Option
transmission (at 5 wavelengths)
water temperature

Chlorophyll 0 - 200 pg Chl-a/l

Measurement procedure spectral fluorometry

Resolution 0.01 pg Chl-all

Transmission 0-100 %

Measuring chamber cleaning

automatic cleaning piston

Housing material

V4A steel | aluminium | coated steel plate

Weight

19 kg

Dimensions (H x W x D)

420 x 600 x 200 mm

Protection class IP 54

Mains voltage 110/ 240V ; 50/60Hz
Power consumption 100 W

Fuse 2x3,15AT

Sample temperature 0-40°C

Sample volume 30 ml

Temperature range while on transport 0-50°C

Relative humidity

Up to 95%, not condensing

Sunlight

indirect

Maintenance interval

> 7 days

Sample inflow

free flow / tube pump

Connection Inlet

6 mm internal hose connection

Connection outlet

6 mm internal hose connection

Sample pump

Marprene Tubing ID = 4.8 mm

Valves (option)

Silicon tubing ID=4.80 / OD=7.90mm

PC

ATOM N270 12" touchscreen panel - ca. 1.6 GHz, 1 GB RAM

0s

Windows XP Pro (SP3)
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Description Value
Hard disk 80 GB
Modem

2 x analogue output 4-20 mA

Outputs (options) 2 x relay output

SDI-12 with bbe converter
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Maintenance

MAINTENANCE

WEEKLY MAINTENANCE :

MAINTENANCE WORK THAT HAS TO BE DONE:

= Check the inflows and drains for blockages
= Check the instrument for leaks

= Clean the hose

MONTHLY MAINTENANCE

MAINTENANCE WORK THAT HAS TO BE DONE:

= Exchange the pump hoses

= Clean the measuring cuvette

HINTS FOR MAINTENANCE WORK

CLEANING OF THE HOSE SYSTEM

1. Stop the measurement

2. Open the hose saddle of the sample pump

3. Connect the water-filled syringe to the instrument instead of the sample
4

Rinse the hose system with pump using the syringe

EXCHANGE THE PUMP HOSES

[
[

(

i
B

L

[
:

C

7R\

The pump turns clockwise. Make sure that the outlet at the right side of the pump is connected to the inlet of the

sensor at the bottom of the sensor!

Hose diameter and hose types

In any case, only hoses in accordance with the specifications must be used!

Marprene hose 4.8 x 1.6 mm (inner diameter x wall thickness)
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Maintenance

The inner diameter can be varied according to the flow needed. To vary the diameter, please refer to the
chapter ‘pump’.

CLEAN THE MEASURING CUVETTE

Stop the measurement

Switch the instrument off

Disconnect influent and effluent tubes directly at the sensor
Disconnect the electrical connector of the sensor

Open the mounting screws at the top and the bottom of the sensor
Take out the sensor and turn it upside down

Open the 4 small screws around the inlet of the sensor

Take off the lid

Clean the cuvette inside and the lid with a smooth cloth

U= e I S R LR R

0. Mount the lid again and be careful with the seal
1

. Mount everything again vice versa

RS232
connection and
power supply

\ //¢ ovor

| inlet
outlet I
/ socket screw

View from the bottom of the sensor. Arrows mark the socket screws which have to be removed to demount the
removable measuring chamber base (lower lid).
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Maintenance

CHANGE FUSES

If the instrument does not start, a fuse may have blown. There are two fuses on the right side of the instrument.
To change them:

¢ Disconnect the mains
e Open the lid

e Take out the fuse

e Replaceit(3.1AT)

¢ Close the lid

Manual for the bbe AlgaeOnlineAnalyser Page 129



Fault finding

FAULT FINDING

THE ALGAE ONLINE ANALYSER WILL NOT START

e |s the Algae Online Analyser connected to the mains?
¢ Is the Algae Online Analyser switched on?
e Are the fuses OK?

PUMP IS NOT RUNNING

o Test the pump by using the “Test pump” option.
e |s the pump mode set to “Always off”

NoO ALGAE CONCENTRATION SHOWN

e There is no sample in the sensor. Maybe because inlet and outlet of the sensor are mismatched

e No sample supply
e |s the pump mode set to “Always off”

GENTY RESULTS ARE ZERO

e The concentration is lower than the minimum concentration

REsuLTS Too Low

e Measuring cuvette is dirty
e The cleaning device is not working. Please check

REsuLTS Too Low OrR Too HIGH

e You are using a different method of chlorophyll calibration than HPLC. So a certain factor has to be used

HumIDITY DETECTED IN SENSOR

e The software shows the following message:

Eror x|

Hurnidity detected in zenzor.
Fleasze check sensar,

Please disconnect the sensor from the power supply and the sample and contact bbe service.
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Troubleshooting

TROUBLESHOOTING

Please call us:

Tel.: +49 431 380 40-40 (Service)
Tel.: +49 431 380 40-0

Fax: +49 431 380 40-10

Or send an email to:

e-mail: bbe@bbe-moldaenke.de

www.bbe-moldaenke.de

We will gladly help you.
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